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chapter 1

Introduction to PostConform

About PostConform
PostConform is an EDL import/autocon-
form software package for Pro Tools™. 
With PostConform, your Pro Tools digital 
audio workstation becomes a complete so-
lution for automatically capturing and as-
sembling sound elements to picture. 

Your complete PostConform package in-
cludes: 
• PostConform Install CD-ROM
• PostConform Authorizer floppy disk
• PostConform User’s Guide
• Customer Service Registration Materials
• One RS-422 cable (Macintosh 8pin-mini-

DIN serial-to-Sony™ 9-pin)

PostConform can import industry standard 
CMX 340, 3400 and 3600 format EDLs, and 
provides machine control support for the 
following protocols: Sony 9-pin, V-LAN, 
and Lynx I & II (VPR-3). PostConform is 
fully compatible with the Digidesign Uni-
versal Slave Driver (USD), and with OMS 
and standard MIDI Time Code-compatible 
interfaces including the MIDI Time Piece™ 
and MIDI Time Piece AV™ (MTPAV) from 
Mark of the Unicorn Opcode’s Studio line 
of MIDI interfaces, and others.

System Requirements

Computer Requirements

• A Digidesign-qualified Power Macintosh
• Mac OS 8.6 or 9.0
• 64 MB RAM

Digidesign System Requirements

• Pro Tools 24 MIX, Pro Tools 24, or 
Pro Tool III hardware

• 888|24 I/O, 882|20, 888 I/O, or 882
• DAE 5.0P (supplied), or DAE 5.0.1

Hardware Requirements for Machine 
Control

• A device that supports Sony 9-pin or 
V-LAN protocol, or a TimeLine Lynx I or 
Lynx II transport synchronizer

• A Universal Slave Driver (USD) or an 
LTC-to-MTC converter or interface
Chapter 1: Introduction to PostConform 1
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PostConform Functions
PostConform allows importing of industry-
standard CMX 3400 and 3600 format 
EDLs, manipulation of the list, automatic 
capture of source elements (through ma-
chine control) and assembly of the re-
corded elements into a Pro Tools session. 
Captured elements can be flexibly sorted 
and edited, and can be conformed again to 
reflect editorial changes. With PostCon-
form, the time-consuming process of load-
ing and conforming field audio and post-
production elements can be accomplished 
automatically and seamlessly. 

Main Features of PostConform

Easy Integration with Pro Tools

PostConform is a stand-alone application 
that imports EDLs, then conforms these el-
ements, creating a new Pro Tools session.

Comprehensive Machine Control 
Support

PostConform supports Sony 9-pin, V-LAN 
and Lynx I and Lynx II protocols for ma-
chine control.

Supports Industry Standard EDLs

PostConform imports industry-standard 
CMX 340, 3400 and 3600 format EDLs. 

Flexible Manipulation of EDL Events 
and Autoconform Preferences

PostConform allows a great deal of flexibil-
ity when dealing with the autoconform 
process with features such as:
• Recording of up to eight tracks.
• Flexible sorting of EDL elements.
• User selectable handles for conformed el-

ements.
• User-definable “checkerboard” of ele-

ments allows avoidance of overlapping 
events, and clean organization of 
Pro Tools tracks.

• Automatic track mapping of source ele-
ments.

• Automatic virtual source creation.
• Elements can be conformed or re-con-

formed (to reflect EDL changes) after 
capture.
PostConform User’s Guide



                               
chapter 2

PostConform Installation and Setup

Installation requires the following steps: 
• Install PostConform software
• Authorize PostConform software
• Make hardware connections for machine 

control (optional)
• Configure PostConform for your com-

puter and Digidesign system

Installing PostConform 
Software

To install the PostConform software on your 
computer: 

1  Insert the PostConform Installer CD-
ROM into your CD-ROM drive. 

2  Double-click the PostConform Installer.

3  Follow the install instructions. When 
prompted for an install location, select 
your system drive.

4  Follow the on-screen instructions to 
complete the installation. 

Authorizing Your Copy of 
PostConform
PostConform is copy-protected with a key 
diskette authorization system. The Autho-
rizer diskette allows you to authorize one 

hard disk to run PostConform. Before you 
authorize PostConform check to make sure 
that the PostConform Authorizer disk is 
not write-protected.

▲ Reformatting or reinitializing your hard disk 
may delete the PostConform authorization 
from your hard disk. Before performing any 
hard disk maintenance, Digidesign recom-
mends temporarily returning the authorization 
key to the Installer disk (for detailed instruc-
tions, see “Deauthorizing Your Copy of Post-
Conform” on page 4).

To authorize your copy of PostConform:

1  Make sure that your audio interface and 
external hard drives are powered on. 

2  Double-click the PostConform icon to 
launch the application. You will be 
prompted to insert the Authorizer disk.

3  Insert the PostConform Authorizer disk. 
In the dialog that appears, click Authorize.

4  When prompted, select the hard disk to 
be authorized.

5  Click OK. You’ll see a couple of status di-
alogs as the Installer authorizes your hard 
disk. 
Chapter 2: PostConform Installation and Setup 3
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6  When authorization is finished, a dialog 
appears confirming that your hard disk is 
now authorized to run PostConform. This 
dialog also tells you how many more au-
thorizations your disk has left.

7  Click OK. You’ll return to the “Autho-
rize/Deauthorize/Quit” dialog. Click Quit 
to exit the authorization program. 

Deauthorizing Your Copy of 
PostConform
On an Authorized hard disk, you can start 
up, use, and even move PostConform to 
different locations on your hard disk with-
out ever being prompted for your Autho-
rizer disk. After you have authorized your 
hard disk, no additional authorizations can 
occur until you reclaim the authorization 
by using the Deauthorization feature of the 
PostConform Installer. 

To deauthorize a copy of PostConform:

1  Insert the PostConform Authorizer disk. 
Make sure that the hard disk that you want 
to deauthorize is connected to the com-
puter and is mounted.

2  Double-click the PostConform DeAutho-
rizer icon on the Authorize disk to launch 
the Installer. 

3  In the dialog that appears, click Setup. 

4  Click Deauthorize in the next dialog. 

5  Make sure the appropriate hard disk is se-
lected and click OK.

A status dialog will appear briefly while de-
authorization takes place. After this, a dia-
log appears confirming that you have re-
placed one authorization:

6  Click OK. When the Authorize/Deautho-
rize dialog appears, click Quit to return to 
the Finder. 

Deauthorization is now complete. If you 
now try to launch PostConform (assuming 
you left a copy on your hard disk) you will 
be warned that PostConform is not autho-
rized, and prompted to authorize the appli-
cation.

▲ Do not lose or alter your PostConform Au-
thorizer disk. You will not be able to install or 
run PostConform without it.

✽ Be sure to register PostConform, to receive 
a back-up authorizer diskette.

Installing OMS
If you are using PostConform with a LTC-
to-MTC converter, you must install Op-
code’s OMS (Open Music System) to enable 
PostConform to recognize and use your de-
vice.

This section provides basic instructions for 
installing and configuring OMS.

Using a MOTU FreeMIDI Device
If you are using a Mark of the Unicorn 
(MOTU) device such as the MIDI TimePiece 
(MTP) or MIDI TimePiece AV (MTPAV) you 
must first install MOTU’s FreeMIDI, then 
install OMS. Instructions for setting up 
your MOTU device for use with Digidesign 
software are included in your MOTU docu-
mentation.
PostConform User’s Guide



                                
About OMS
OMS acts as a central MIDI driver for Post-
Conform and other audio/MIDI applica-
tions and devices. PostConform uses OMS 
to communicate with MIDI-based synchro-
nization peripherals. OMS also provides a 
central location for defining and storing a 
detailed description of your MIDI studio.

OMS Setup 

The OMS Setup application is used to cre-
ate a Studio Setup document, where you 
store a detailed description of the MIDI de-
vices in your studio—including their 
names, their MIDI channels, and how they 
are all physically connected. 

All OMS-compatible applications reference 
this Studio Setup document. So, if you 
change your studio in any way, you need 
only modify your Studio Setup document 
and all OMS-compatible applications are 
immediately aware of the change. 

OMS handles all your computer’s internal 
MIDI timing. This allows you to run multi-
ple OMS-compatible applications simulta-
neously and in perfect synchronization.

Installing OMS

The OMS Installer is located on your Post-
Conform Installer CD-ROM.

To install OMS:

1  Insert the PostConform Installer CD in 
your CD-ROM drive. 

2  Open the “OMS Installer” folder and 
double-click the OMS installer.

3  At the Install Screen, select the Easy In-
stall option, and set the Install Location to 
your Startup hard drive. Click Install.

4  Follow the on-screen installation instruc-
tions.

5  When the installation is complete, re-
start your Macintosh.

If you are updating from an older version 
of OMS, your previous Studio Setup docu-
ments will be read by the new OMS Setup 
application.

Configuring OMS
The OMS Setup application is used to cre-
ate a Studio Setup document, where a de-
tailed description of the MIDI devices in 
your studio is stored. This description in-
cludes device names, their MIDI channels, 
and how they are connected. 

To configure OMS:

1  Make sure your MIDI devices and MIDI 
interface are connected properly and 
turned on. 

2  Double-click the OMS Setup application. 

3  Select the serial ports you want to use for 
transferring MIDI data between your MIDI 
interface and Pro Tools, then click Search.

4  Follow the on-screen instructions.

5  After OMS has scanned your MIDI setup 
and configured your MIDI interface and 
connected MIDI devices, enter a name for 
your Studio Setup document and click 
Save.
Chapter 2: PostConform Installation and Setup 5
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Disabling Serial DMA
PostConform requires that you deselect the 
“Use Apple Serial DMA Driver When Avail-
able” option in OMS Setup. If you do not 
disable this option, problems will occur 
with MIDI and synchronization functions 
within Pro Tools. 

To disable Serial DMA in OMS:

1  Double-click the OMS Setup application.

2  Choose Edit > Preferences.

3  Deselect “Use Apple Serial DMA Driver 
When Available” and click OK. 

4  Quit OMS Setup.

Hardware Connections for 
Sync and Machine Control 
If you are already using Pro Tools with a 
Sony 9-pin or V-LAN deck, PostConform 
should require no additional hardware 
connections. You will still need to config-
ure PostConform’s Peripherals and Hard-
ware Setup for your particular setup. See 
“Configuring PostConform” on page 7.

For synchronization, PostConform re-
quires a USD or MTC synchronizer connec-
tion. For optional machine control, Post-
Conform requires a 9-pin or V-LAN 
machine control connection. 

To connect your PostConform system for 
synchronization and machine control:

1  Connect your synchronization periph-
eral to your computer, and install and con-
figure the peripheral for use with 
PostConform.

2  Using the 9-pin cable included with Post-
Conform, connect your computer to the 9-
pin In port of your VTR/ATR, or a Lynx I or 
II or VLAN machine. 

3  Connect your SMPTE or MIDI Time Code 
source to your synchronization peripheral. 

☞ You can find detailed hardware connection 
diagrams and suggestions in your Pro Tools 
TDM Hardware Install Guide. 

PostConform and Virtual 
Memory
PostConform will not launch if Virtual 
Memory is active. To disable it, open the 
Memory Control Panel, disable Virtual 
Memory and reboot the Macintosh. 

PostConform Quick Start
Once you’ve installed and authorized 
PostConform you can launch it by double-
clicking its icon in the Finder. To make sure 
you start the program correctly, take a mo-
ment to look at the steps listed in this sec-
tion. 
PostConform User’s Guide



                        
To launch PostConform:

1  Turn on your external hardware, includ-
ing connected synchronization peripher-
als, and your Digidesign audio interface.

2  Locate the PostConform application on 
your system drive (usually in Digidesign: 
PostConform).

3  Double-click the PostConform icon. 

Learning PostConform
If you are an experienced post editor, 
chances are you can get up and running in 
just a few minutes. Read “Configuring Post-
Conform” on page 7 to learn how to set up 
your peripherals for use with PostConform, 
and hardware setup options for your partic-
ular system. 

If you are new to autoconform in general, 
you might want to take a few minutes to 
read Chapter 3: Basic PostConform Concepts 
before continuing. After that you can pro-
ceed to Chapter 4: Using PostConform and 
start putting PostConform to work.

Configuring PostConform
After you’ve installed PostConform and 
launched it you’ll want to configure it for 
your system and for your work style. Fol-
low the instructions in this section to set 
up PostConform for your hardware and pe-
ripherals.

Hardware Setup
The first time you launch PostConform the 
Hardware Setup dialog appears (you can 
also access this dialog by choosing Setups > 

Hardware). The Hardware Setup dialog al-
lows you to configure PostConform for the 
specific Digidesign hardware installed in 
your system. The Hardware Setup dialog 
also provides controls for selecting analog 
or digital input. Configure your inputs and 
sample rate to match the sources you will 
be working with. Since PostConform is a 
utility application for Pro Tools, you 
should configure the Hardware Setup dia-
log according to the instructions found in 
your TDM Hardware Install Guide. 

Peripherals
PostConform has its own Peripherals setup 
dialog to allow you to tell the application 
what devices are connected to your system, 
and what port each device is on.

Before you attempt to configure PostCon-
form from the Peripherals dialog, you must 
connect your peripheral devices, including 
a USD or an MTC-capable sync peripheral, 
and any machine you wish to control. Re-
fer to your device’s documentation for 
proper connection and installation proce-
dures.

Peripherals dialog
Chapter 2: PostConform Installation and Setup 7
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Configuring a Sync Peripheral

You can use a Digidesign USD, or an LTC-
to-MTC converter, to synchronize Post-
Conform to your source decks.

To configure a PostConform sync peripheral:

1  Launch PostConform, using the proce-
dure “To launch PostConform:” on page 7.

2  Choose Setups > Peripherals. 

3  Under Sync Peripheral Device, select ei-
ther Universal Slave Driver (USD) or Generic 
MTC Reader from the pop-up menu.

4  Under Sync Peripheral Port, select the 
port your sync peripheral is attached to 
from the pop-up menu. For example, with 
a Pro Tools MIX system and a USD, the 
USD should be connected to the DigiSerial 
Port.

5  When you finish configuring the sync 
peripheral, click OK.

✽ Note that in the pop-up menu, ports that are 
already in use are grayed out, with an explana-
tion of the port’s current assignment.

Configuring a Machine for Machine 
Control 

To configure a machine for machine control:

1  Launch PostConform, using the proce-
dure “To launch PostConform:” on page 7.

2  Choose Setups > Peripherals. 

3  Select Enable Serial.

4  From the pop-up menu, select the type of 
machine (Sony 9-pin, Lynx [VPR-3], or 
VLAN).

5  From the Port pop-up menu, select the 
port the machine is attached to.

6  From the Node pop-up menu, select the 
Node the machine is attached to:
• (VLAN) Click and hold the Node pop-up 

to select the machine on the network 
you want to control.

• (9-pin) Click and hold the Node pop-up 
until “Connected” is highlighted.

7  Enter a pre-roll amount, in frames.

8  Click OK when you are done.

Handles, Machine Pre-Roll, and 
Discontinuous Time Code (Warning!)

Be careful with handle settings, machine 
pre-roll, and tapes with discontinuous time 
code. If your handle size is 150 frames, and 
your machine pre-roll is 150 frames, you 
need to have 10 seconds (at 30 FPS) of con-
tinuous time code recorded on tape before 
the event you are attempting to capture. 
Since this is not always the case with pro-
duction sound, you may have to adjust 
handle and machine pre-roll settings ac-
cording to your project’s parameters.

Other Configuration Options
In addition to Hardware and Peripherals 
setup, PostConform has a Preferences com-
mand that lets you set your preferences for 
loading, conforming, and EDL display. See 
“Preferences” on page 31 for more infor-
mation.
PostConform User’s Guide



chapter 3

Basic PostConform Concepts

Features and Uses of 
PostConform
PostConform is auto-assembly software. It 
helps to automate much of the process 
when loading audio into Pro Tools and 
spotting audio to a Pro Tools session for 
video, film, or multimedia post produc-
tion. 

To understand how PostConform works 
compared to a traditional “manual” ap-
proach, look at the following scenarios for 
loading source material into a digital audio 
session. 

Manual Loading and Spotting of 
Audio Events with an EDL and a 
DAW
The following procedure is a typical exam-
ple of what an audio post-production engi-
neer goes through to add audio tracks man-
ually to a production using a DAW:

1  A printed cue sheet or EDL, along with a 
video worktape, is provided by the video or 
film editor to the audio post-production 
engineer or production sound editor. This 
EDL usually indicates which audio events 
(also called edits or takes) need to be loaded 
into the workstation, to match the work-
tape’s audio guide track and visuals.

2  The EDL also usually indicates the num-
bers or names of the various audio and 
video tapes (called source tapes, or reels) 
where the desired takes can be found. The 
engineer loads the first audio or video tapes 
onto the source deck (this could be a time 
code DAT machine, a professional video 
deck, or a time code-capable open-reel ana-
log deck), and cues it manually to the 
Source In (start) time code point for the first 
audio event, as shown on the EDL. (The en-
gineer might record audio starting a little 
before the Source In time for editing flexi-
bility; this is called a handle.)

3  The DAW is put into record, and the 
source deck is started.

4  Once the tape gets to the edit’s Source 
Out (stop) time, recording is stopped on 
the DAW, and the source deck playback is 
stopped. (The engineer might also leave a 
handle at the end of the audio.) 
Chapter 3: Basic PostConform Concepts 9
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5  Each newly recorded event is saved to 
hard disk as an audio file.

6  This process is repeated for all the needed 
events on the first source reel. Once all 
events for that source reel have been trans-
ferred, the engineer off-loads the reel, and 
if needed, puts on another reel. Steps 2 
through 5 are repeated for all necessary 
events and reels.

7  Once all the events from all the source 
reels have been captured to disk, the engi-
neer usually records the audio guidetrack 
off of the video worktape onto disk. This 
guidetrack can be very useful.

8  Referring to both the printed EDL and 
the guide track, the engineer manually 
“spots” each file to a track and a Record In 
(also called destination in, or record start) 
time code point. Since it is assumed to be in 
sync with the video, the guide track is used 
in two ways. First, processed dialogue and 
other elements can be matched up visually, 
comparing the waveforms of the guide 
track with that of the new regions. Second, 
new regions can be compared audibly with 
the guide track; this way, particularly with 
dialogue, it is possible to hear “phasing” 
mismatches when the sync isn’t right. Even 
with the help of a guide track and a printed 
EDL, however, this process of manually 
“conforming” regions to EDL times can be 
time-consuming. 

9  If audio takes overlap in time, the engi-
neer often places them on adjacent tracks. 
This is called checkerboarding.

10  Once all the events are in place for the 
session, the engineer can synchronize the 
workstation to the worktape of the scene to 
see how well the audio matches the visuals. 
Any additional edits, or digital signal pro-
cessing, including level, and EQ, can also 
be performed now, and sound effects or 
other additional audio elements can be 
added.

This is the manual process of conforming 
audio. As you can see, it is time-consum-
ing, labor-intensive, and there are opportu-
nities for error.

Auto-Assembly of Audio Events 
Using PostConform
Here’s an overview of how you can accom-
plish the same tasks as in the previous sce-
nario, using PostConform software with 
Pro Tools:

1  The video or film editor gives the audio 
post-production engineer an electronic 
EDL on a diskette. Typically, the post-pro-
duction engineer also gets a video work-
tape with an audio guidetrack. The EDL 
contains information that describes the ad-
dresses of dialogue and other audio events 
that the picture editor has incorporated on 
the worktape. It also tells which source 
reels contain the desired audio takes. Using 
PostConform, the engineer imports the 
EDL from the diskette, and reads which 
source reels will be needed for this particu-
lar scene.
PostConform User’s Guide



2  The audio engineer loads the first source 
reel onto the source deck, and defines 
which input channels will map to which 
destination tracks. Next, that reel’s desired 
events are selected from the EDL, and Post-
Conform is to load them from the source 
reel automatically. Alternatively, all the 
source events can be selected, and Post-
Conform can prompt the engineer to 
change reels as events are recorded in.

3  Using its built-in machine control capa-
bilities, PostConform advances the source 
reel to the first take’s Source In time, as in-
dicated in the EDL.

4  PostConform puts the DAW into record 
mode and starts the source reel. When the 
reel reaches the event’s Source Out time, as 
also indicated in the EDL, recording is au-
tomatically stopped, and the file is saved to 
the system’s hard disk. If desired, PostCon-
form can record user-specified amounts of 
handle before and after the source event.

5  PostConform then advances the source 
reel to successive events, and repeats step 4, 
until all the desired events for that reel are 
transferred to the hard disk.

6  If necessary, the engineer loads addi-
tional source reels, and asks PostConform 
to repeat these same steps until all the de-
sired takes from all the desired source reels 
are captured to the disk. Or, if all the events 
on multiple reels were selected earlier, the 
engineer is prompted to insert the next 
reel.

7  PostConform can then export a Pro Tools 
session, but the engineer may want to set 
up the layout of that session first. From 
within PostConform the track layout for 
checkerboarding is selected, or separate 
tracks are selected for dialog, ambience and 
effects. The frame rate and start frame of 
the Pro Tools session are also set.

8  PostConform automatically exports each 
event as a region into a new Pro Tools ses-
sion. At the same time, each region is auto-
matically spotted, or conformed, to its 
Record In time, as indicated in the EDL. 

9  Once regions are in place, it’s a good idea 
to make sure they match the visuals. Dia-
logue, for instance, can be checked visually 
and audibly against the worktape’s guide 
track (this is one way to make sure that EDL 
times are correct). To check the placement 
of other elements, it’s a good idea to syn-
chronize Pro Tools to the video worktape. 
This step will let you check to make sure 
that the audio events match the visuals. Fi-
nally, if you like, you can add effects, addi-
tional edits, or other audio elements.

Note that PostConform doesn’t necessarily 
reduce the actual number of steps that 
need to take place. However, it can save a 
tremendous amount of operator time and 
energy, since many steps, such as audio re-
cording and spotting, are automated.
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A Summarized Overview of 
PostConform
In short, PostConform adds auto-assembly 
capabilities to Pro Tools. These capabilities 
include three primary functions:

EDL importing PostConform imports and 
lets you read edit decision lists created by 
external video or audio editing systems.

Auto-Loading Using its built-in machine 
control capabilities, PostConform auto-
matically loads audio events off source 
reels from external audio or video decks (or 
DAWs) onto your Pro Tools system’s hard 
disks. Some audio post engineers may 
know this feature as auto-editing, or auto-ac-
quisition.

Autoconform PostConform automatically 
matches, or conforms, auto-loaded events 
with predetermined destination, or record, 
times, as described by the EDL. Conformed 
events are then exported as audio regions 
into a new Pro Tools session, where they 
are also automatically spotted to their cor-
rect times. 

EDLs in Video, Film, and 
Multimedia Editing 
Systems
There are two main types of video editing 
systems that produce electronic EDLs. Con-
ventional videotape editing systems typi-
cally control one, two, or more source 
video tape recorders (VTRs), plus a master 
VTR. Some of the best-known videotape 
editing systems are made by CMX, Sony, 
Ampex, and Grass Valley. 

Nonlinear digital video editing systems, 
such as Avid Media Composer and Sym-
phony, also produce EDLs. These systems 
capture, compress, and store video infor-
mation to hard disks, so that scenes and ed-
its can be performed entirely within the 
digital domain. We’ll describe the relation-
ship between these systems and EDLs in 
“EDLs in Video, Film, and Multimedia Ed-
iting Systems” on page 12.

Basics of Electronic EDLs
Edit decision lists have been part of video-
tape editing for years. Most videotape edit-
ing systems use SMPTE or EBU time code 
edit points (also called addresses) to de-
scribe where specific video and audio 
events start and end. To create a finished 
production, events from the source (origi-
nal) video and audio tapes are recorded 
onto a master tape, or master reel. The list 
of events that is used to assemble the mas-
ter tape is called an edit decision list. 

An EDL can be as simple as a handwritten 
log of event addresses and circled takes. 
Professional video editing systems, how-
ever, use electronic EDLs to keep track of 
what events are to be assembled. Electronic 
EDLs also help these systems to automate 
the process of transferring video off source 
tapes and onto the master tape, similar to 
PostConform auto-assembly. 

An EDL usually lists two pairs of addresses 
for each event: the Source In and Source Out 
times, which describe where the event be-
gins and ends on the source reel, and the 
destination or Record In and Record Out 
times for each event, which describe the 
times on the assembled master reel where 
the event begins and ends. 
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Electronic EDLs usually contain more in-
formation than addresses. For instance, 
they usually indicate the event number, 
the names (or numbers) of the source tapes 
for each event, and whether a particular 
event is an audio or video event (or both). 
Most EDLs also have a comment field for 
each event, where the operator might 
choose to give the event a name, or add a 
special note about the audio level, where 
the source reel is stored, and so forth. 

Online and Offline Videotape 
Editing
The ability to store an EDL to internal 
memory or to diskettes is vital for profes-
sional videotape production. Here’s an ex-
ample.

Most video production companies have 
both offline and online editing suites. Of-
fline videotape editing uses dubbed copies 
of the original source tapes (work tapes) to 
create a “mock-up” master tape. Once an 
offline edit has been performed to every-
one’s satisfaction, the offline editing sys-
tem can store the session’s EDL onto a dis-
kette that can then be carried over to the 
online system. There, once the EDL is read 
from the diskette, the original source tapes 
can be shuttled directly to their events’ 
Source In times, to be transferred over to 
the actual master tape or hard disks. 

By performing basic edit decisions offline, 
wear-and-tear on the source tapes is mini-
mized. Also, the online suite usually has 
better-quality switchers, video decks, char-
acter and special effects generators, and 
more—and accordingly, costs more per 
hour to run than the offline system. 

✽ Don’t confuse online and offline editing with 
Pro Tools’ online/offline settings, which deter-
mine whether or not the system is set to slave 
to external time code; these are two entirely 
separate concepts.

Online or offline EDLs are stored internally 
or saved to diskettes at the end of each ed-
iting session. This way, someone else can 
come in, load their own EDL, do their 
work, and leave, and any video editor can 
pick up a session later by simply reloading 
an EDL, without having to re-input all the 
events. As you might guess, storing differ-
ent versions of edits is as simple as storing 
different EDLs, like storing different ver-
sions of similar Pro Tools sessions. 

PostConform allows your Pro Tools system 
to be included in this editing model, by 
sharing EDL data generated on a video ed-
iting system. 

Nonlinear Digital Editing 
Systems and EDLs for Film 
Production
Avid Media Composer and Symphony and 
other nonlinear editors are increasingly 
used for offline and online editing. For the 
experienced video editor, these systems of-
fer unmatched speed and flexibility.

For feature film editors, on the other hand, 
editing has historically been a manual pro-
cess. Instead of an electronic editing sys-
tem, they wind and splice together by hand 
sprocketed film and “mag” stock. Instead 
of an EDL, they compile each splice’s scene 
and take the number (read from special 
codes printed on the film) onto a handwrit-
ten list called a chronolog. Consequently, 
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audio-for-film people have rarely had the 
need or opportunity to work with elec-
tronic EDLs. 

Today, this is changing, as more feature 
film editors turn to digital video editing 
systems, such as the film-oriented Avid 
FilmComposer. With these systems, each 
reel of film is transferred onto a video 
worktape that in turn is captured onto a 
shared or dedicated hard disk storage sys-
tem to allow random-access editing of the 
visuals. 

Similar to a videotape editing system, digi-
tal video editing systems use EDLs to as-
semble events, which can be shared with 
PostConform. When editing digitally for 
film production, there’s usually one EDL 
for each 10-minute reel. For a video pro-
duction, there could be a separate EDL for 
each scene or section, or just one EDL for 
the entire production. Technically speak-
ing, a “reel” is an actual reel of film; how-
ever, almost all film post-production work, 
is split up into master sections called reels.

EDLs and Professional 
Multimedia Production
Audio post production for multimedia is 
increasingly important. Here too, PostCon-
form can be of assistance. 

Many professional multimedia produc-
tions are created using authoring/editing 
software, such as Macromedia Director or 
Adobe Premiere. The same high-end non-
linear digital video editing systems, how-
ever, that are being used in video and film 
production, are also being employed to cre-
ate multimedia productions. Using EDLs to 
assemble finished projects from a variety of 

digital or video tape sources, these systems 
also generate industry-standard EDLs—
which means that they too can be used 
with PostConform. 

EDLs are a Common Language 
Between Audio and Video 
Editors
As we’ve described in the preceding pages, 
EDLs can be a common language for visual 
and audio editors to share. Here are some 
more detailed examples of this.

In many video productions, as different 
cuts are being created by the visuals edi-
tors, video worktapes and EDLs are passed 
along to the audio editors, who use them to 
assemble dialogue and other audio events, 
either manually, or using an autoconform 
process. As certain portions of audio are as-
sembled, they’re often sent back to the film 
or video editors as work-in-progress, on 
time code DAT or analog tape. 

With a digital video editing system, the di-
rector and others view the production in 
progress at the system, or they might view 
generated worktapes. As the production 
progresses, EDLs and video worktapes (or 
increasingly, digital video on disk) are 
passed to the audio post-production engi-
neers. Audio-in-progress may be sent back 
up the line to the visuals editors.

For nonlinear film post-production, as the 
director signs off on portions of the visual 
production, the film editor gets a printout 
of something similar to an EDL, called a 
negative cut list; this gives one all the in-
structions needed to cut the film (literally) 
from the source reels onto a master reel. 
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Once the visuals are cut, and the audio 
post-production is complete, final audio 
tracks are mixed to the film’s optical tracks. 

Special Advantages of 
PostConform and Nonlinear 
Digital Video
As we’ve been discussing, most audio post-
production uses video worktapes. However, 
digital video technologies with Pro Tools, 
like QuickTime movies, AVoption or 
AVoption XL, can be used to view picture 
and spot audio accurately. 

If your picture editor can export a Quick-
Time movie, you can easily import this 
movie into Pro Tools, then view near-
frame accurate video with your audio ses-
sion to check sync and complete post-pro-
duction.

You can also use Pro Tools with AVoption 
or AVoption XL, to import and view Avid-
format video in your Pro Tools session. 
Since picture editing is often performed on 
an Avid system, this can be an invaluable 
method of checking sync and completing 
post-production.

☞ For more information on using QuickTime 
video in Pro Tools, refer to the Pro Tools Refer-
ence Guide. For information on AVoption or 
AVoption XL, refer to the Digidesign Web site.
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How to Read a Typical EDL 
In an ideal world, you’ll always be given 
nicely formatted EDLs, without any extra-
neous or unrelated information. However, 
EDLs share a specific language and syntax. 

Here’s an example of a portion of an EDL, 
as it might look on-screen at a video or 
nonlinear editing station, or as it might 
look on the Macintosh, when opened up as 
a text file:

✽ Keep in mind this is what a typical EDL 
looks like coming directly from a video or non-
linear editing system. Once it’s imported into 
PostConform, certain columns may be ignored 
and other information is added.

To help us learn how to read this and other 
EDLs, let’s start at the very top, and then 
move onto each vertical column. 

TITLE: ALL SPOTS    

FCM: NON DROP FRAME

001   2POP     A    C       00:58:45:10    00:58:45:11   00:59:58:00   00:59:58:01

002   VO       A    C       03:00:30:22    03:00:33:12    01:00:02:27    01:00:05:17

003   VO       A    C       03:01:29:21    03:01:31:19    01:00:07:09    01:00:09:07

004   VO       A    C       03:00:56:15    03:00:59:01    01:00:09:19    01:00:12:05

005   DIA       AA   C       01:09:12:01    01:09:14:01    01:00:13:20    01:00:15:20

006   VO       A    C       03:02:02:12    03:02:04:23    01:00:19:02    01:00:21:13

007   VO       A    C       03:02:51:06    03:02:53:00    01:00:23:06    01:00:25:00

008   2POP     A    C       00:58:45:10    00:58:45:11    01:00:58:00    01:00:58:01

009   VO       A    C       03:03:17:23    03:03:22:05    01:01:09:24    01:01:14:06

010   VO       A    C       03:04:10:24    03:04:12:15    01:01:17:17    01:01:19:07

011   VO       A    C       03:03:44:14    03:03:48:06    01:01:19:12    01:01:27:21

012   VO       A    C       03:02:23:24    03:02:24:24    01:01:26:21    01:01:27:21 

Event

Title

FCM

number

Reel
name

Source start Source end Destination
(record) start

Destination
(record) stop

Channel

Effect
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Title and FCM

 

The top of the EDL is reserved for general 
information, including the EDL’s title. FCM 
stands for Frame Code Mode (25 FPS, drop 
frame, or non-drop), and it’s here that 
you’ll find the general time code format for 
the destination, or master tape. Separate el-
ements on the EDL can have different 
source frame rates, but the destination 
(master) tape must have continuous, con-
sistent time code.

 

Standard EDL Statements

 

Event

 

As you can see, this sample EDL has succes-
sively numbered events listed horizontally, 
with columns for event number, reel name, 
channel, effect, start and end times for the 
source reel, and a start and end time for the 
session. Each event represents a video or 
audio edit that has been assembled by the 
editor for this particular portion of the 
master tape. In this case, the EDL has been 
sorted by event numbers and Record In 
times.  

Reel

 

This is the identifying name of the source 
reel for each event. Smaller films and video 
productions typically have anywhere from 
one or two source reels to several dozen, 
while feature-length productions can have 
hundreds.

 

Channel 

 

This tells what type of information the 
event is, and from which audio or video 
channel the information is loaded. Here’s a 
legend for reading channel codes: 

 

V: 

 

Video only 

 

A: 

 

Audio channel 1 only

 

A2: 

 

Audio channel 2 only

 

B: 

 

Audio channel 1 & video

 

A2/V: 

 

Audio channel 2 & video

 

AA: 

 

Audio channels 1 & 2

 

AA/V:  

 

Audio channels 1 & 2, & video

 

NONE:  

 

Audio channel 3, or 4, or both 
3&4*.

CMX 3600 format EDLs allow for up to 
four channels of audio. These are described 
by “AUD” statements that are found imme-
diately underneath an event’s ordinary 
channel codes of V, A, A2, and so forth. If, 
however, the event has only audio channel 
3 or 4, or both—and nothing from audio 
channels 1 or 2, nor any video—then the 
first statement of the channel column for 
that event will say NONE, followed by an 
“AUD” statement. Here, then, are the three 
AUD codes:

 

AUD 3: 

 

Specified channels or NONE + 
audio channel 3

 

AUD 4: 

 

Specified channels or NONE + 
audio channel 4

 

AUD 3 & 4: 

 

Specified channels or NONE + 
audio channels 3 & 4

Also, please note that to avoid confusion, 
we refer to source tracks as “channels,” 
even though many video editing systems 
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may call them “tracks.” We do this because 
PostConform uses the term “track” to de-
scribe the destination track(s) for each 
audio event. In fact, once an EDL is im-
ported into PostConform, each audio event 
will indicate both “channel” and “track.” 

Effect

This describes the edit transition. Usually 
this is simply a “butt-splice” cut (C), where 
once scene abruptly cuts to another, 
though a dissolve (D) is also very common. 
This column is ignored when EDLs are im-
ported into PostConform. All edits are 
given butt splice-type edits. 

Duration (not shown)

If the edit transition is anything other than 
a cut, this tells us the duration of the effect. 
This column is also ignored when EDLs are 
imported into PostConform (and when 
Pro Tools sessions are exported). 

Source In

The playback start time for each event, as 
found on the original source reel.

Source Out

The playback end time for each event, as 
found on the original source reel.

Record In

The “destination” start time where an 
event is recorded onto the master tape. 

Record Out

The “destination” end time on the master 
tape where an event stops recording. 

Other Types of EDL Statements

Comments

The CMX standard allows for Note state-
ments that occupy their own individual 
line in the EDL. Since Comments refer to 
the previous event, PostConform displays 
them in the farthest right-hand column. 
Editors often use Comments to name 
events, and to provide pertinent informa-
tion about the event for themselves and 
other post-production people. PostCon-
form is able to display the Comments col-
umn and use its contents as the region 
name in Pro Tools. 

The CMX specification does not include 
Comments on the same line; Comments 
must be in their own line. They are, how-
ever displayed in their own column (far-
thest right-hand) in PostConform, and can 
be viewed and edited from the Statement 
Info dialog. They are optionally shown in 
their own line when elected to be shown, 
in the preferences page.

GPI

Video EDLs often include general purpose 
interface (GPI) events, or GPI triggers. 
Video editing systems have electronic 
switches that can be triggered to deliver a 
momentary contact. This way, some exter-
nal event can be triggered by the editing 
system. It’s quite common, for instance, to 
have such triggers connected to character 
generators (to insert a title); digital video 
effects units (to move a graphic onto the 
screen); an audio cart machine; or even a 
digital audio sampler (to trigger a sound ef-
fect). 
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Audio post engineers, for the most part, 
choose to ignore such events; you can ask 
PostConform to ignore them when it im-
ports an EDL. However, in some circum-
stances this information can be useful. For 
instance, if you’re trying to match a sound 
effect or pace a dialogue to a title’s entrance 
on-screen, it may be very useful to know 
the start time for its associated GPI trigger 
event.

Sort Modes

✽ “C” Mode is the default mode that PostCon-
form uses to load audio, as it makes the most 
efficient use of the source reels. To load video 
in any other order, you must manually select 
the events in the order you wish to load them.

There are three primary ways to sort the or-
der of an EDL’s events: 

“A” Mode

The same as shown in the above EDL. 
Events are sorted and numbered according 
to their respective Record In times. Video 
editors use this mode when they need to 
assemble the master tape in a linear fash-
ion, from start to finish. It does, however, 
require extra time for transferring the 
source events, since they are ordered at 
varying Source In times and on varying 
source reels. 

“B” Mode

Events are sorted by source reel first, then 
the Record In time for each event (i.e., 
“show” order); consequently, event num-
bers are almost always out of sequence. In 
this process, the master tape is assembled 

in a nonlinear fashion. “B” Mode EDLs are 
used when the editor prefers to use source 
reels one at a time, without having to off-
load and reload the reels. Also, shuttling of 
the master tape during each reel is mini-
mized.

“C” Mode

Events are sorted by source reel first, then 
the Source In time for each event (i.e., 
“source” order). Similarly to a “B” Mode 
EDL, the master tape is assembled out-of-
order. Event numbers in the EDL will also 
be out of sequence. With “C” Mode EDLs, 
source shuttling time is minimized, since 
events are loaded off the source reel in or-
der of Source In time. However, it does re-
sult in more master tape shuttling. 

Occasionally, video editors use “D,” “E,” 
and other mode EDLs. D Mode lists are sim-
ilar to A Mode lists, and E Mode lists are 
similar to C Mode lists. The main differ-
ences between them are that D and E Mode 
lists place all dissolves and other special 
transitions at the end of the list. 

EDL Formats and Other 
Variables
An electronic EDL is similar to an ASCII 
text-only file that you might find on a per-
sonal computer. Unfortunately, different 
editing systems use different text and dis-
kette formats to store and read EDLs. In 
other words, not all EDLs are created equal. 
Aside from the various Modes discussed 
above, there are several other important 
variables that you’ll need to consider when 
importing EDLs into PostConform. 
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EDL Formats

The first variable is the EDL format. In gen-
eral, the universal language for EDL for-
mats is CMX. But CMX has several distinct 
EDL formats. Two of its most popular are 
CMX 3600 format (4 channels of audio) 
and the older CMX 3400 format (2 chan-
nels of audio). 

CMX 3600 and 3400 are the only two EDL 
formats that PostConform can import di-
rectly. Practically every current video or 
high-end nonlinear editing system is able 
to save lists in one or both of these CMX 
EDL formats. Don’t assume, however, that 
you’ll always be given a 3600 or 3400 EDL: 
It’s vital that you communicate what you 
expect to receive to the colleague who will 
be sending you the diskette.

Diskette Format

If you are using PostConform in conjunc-
tion with a nonlinear editing system, such 
as Avid Media Composer, Symphony, or 
FilmComposer, your problems are mini-
mized, since your Macintosh can read files 
from any of these systems, including DOS 
diskettes, easily. 

This may be more problematic if the sys-
tem outputs an older diskette format called 
RT-11. Some of the older editing systems 
generate 5-1/4" or even 8" diskettes—in 
which case your best bet is to enlist the 
help of a well-equipped and knowledgeable 
video post house, to convert the disks to 
3-1/2" DOS or Macintosh format.

Unusual EDLs

What if your EDL is filled with irrelevant 
information? What if you’ve received a 
non-CMX-format EDL? What if someone 
has sent an RT-11 diskette your way? These 
problems can be remedied.

To understand what we really want, let’s 
consider the perfect PostConform-ready 
diskette. It will, naturally, be a Macintosh 
diskette with a CMX 3600- or 3400-format 
EDL. What this means is that it’s a diskette 
that can be mounted on the Macintosh 
desktop, with a text-only file that PostCon-
form can understand. By “understand,” we 
mean that PostConform is going to expect 
to see a very particular sort of text file, with 
the character spacing, layout, columns, 
and terminology associated with 3600 or 
3400 EDLs. And being a text file, we could 
open with TeachText, SimpleText, or any 
word processor, to view or even modify the 
EDL before you import it into PostCon-
form.

Modify, we say? Even if you’ve received the 
correct EDL and diskette formats, your EDL 
may still need some “cleaning.” Here are 
some examples of problems that need to be 
cleaned:
• There may be numerous events that you 

know you won’t be needing. So rather 
than import some huge long list into 
PostConform, you may prefer to “weed 
out” the unwanted events, perhaps using 
a printed list with circled takes as your 
guide.

• You could be warned of, or come across, 
mistyped reel numbers, comments, or 
other information erroneous entries.
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• You could even, if you know what you’re 
doing, modify the spacing, layout, or 
other features of a non-CMX-format 
EDL, and save it as something that looks 
just like a 3600-format EDL.

To accomplish these and other feats, 
there’s a Macintosh software utility on the 
market called EDL™ Pro, from a company 
called ALBA™ Editorial 
(www.albaedit.com). This program not 
only lets you view and modify almost any 
EDL, but it also converts almost any EDL 
format to another, including CMX 3600 or 
3400. Furthermore, EDL Pro can mount an 
RT-11-format diskette. In other words, EDL 
Pro will let you receive otherwise incom-
patible EDLs and convert them to be Post-
Conform-compatible.

It is also possible for you to edit, clean, and 
modify an EDL within SimpleText or an-
other text utility, rather than buy EDL Pro. 
If you attempt this, we strongly recom-
mend you work on a backup copy of the 
file, and if possible, that you engage the as-
sistance of someone who has had direct ap-
plicable experience. 

PostConform uses a space (or Tab) delin-
eated method of separating fields. It ex-
pects to see first the Event Number, then a 
Reel Name, then a Channel Set, then an 
Edit Type, then, if it’s a dissolve or some 
kind of wipe, either a duration or a wipe 
code (these are ignored by PostConform), 
then the four most important time code 
addresses in order: Source In, Source Out, 
Record In and Record Out. The delimiter 
for these time code addresses can be some-
thing other than a colon (as in 

01:00:00:00) such as a semicolon (some-
times used to denote Drop Frame, as in 
01;00;00;00).

Possible Sources of Time Code 
Trouble
In theory, once PostConform has auto-as-
sembled your audio events, the newly im-
ported and conformed audio regions 
should match the visuals perfectly. In the 
world of audio post, however, there may be 
times when these regions may be off by 1 
or 2 frames, or even more.

There are several possible reasons for this 
sort of problem. The following issues illus-
trate common circumstances where you 
might run into sync problems: 

Improper FCM Code When PostConform 
autoloads events, it looks to the top “FCM” 
code on the EDL. That code will determine 
the time code format for the entire session. 
Then, if it reaches one or more events with 
a different FCM code, it will automatically 
record those events with the different (and 
correct) time code format. However, if an 
FCM code has been improperly logged in 
the EDL—say, if drop frame time code is in-
dicated when a source tape is actually non-
drop frame—then you might find audio re-
gions that don’t match the visuals. The de-
gree to which these elements are out of 
sync would be 108 frames (3 seconds, 18 
frames) per hour. If your event is at 
02:00:00:00 on a drop-frame tape labeled as 
non-drop that starts at 00:00:00:00, then it 
will be off by 216 frames (approximately 7 
seconds). 
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Address Typo If a time code address has 
been mistyped during the creation or edit-
ing of the EDL, you could wind up with a 
sync error.

Dubbing Errors If you’re working on a video 
production, it’s unlikely that time code er-
rors will be introduced when your video 
worktape is created. However, if you’re 
working on a film production, your video 
worktape may have been dubbed from an-
other tape, which could have been dubbed 
from film dailies, which were printed off 
the film stock. 

Keep in mind that when film is transferred 
to videotape, 24 frames per second of film 
must be converted to 29.97 frames of video 
in NTSC format, or 25 frames in PAL/SE-
CAM format. Even if the proper Pull Down 
transfer techniques have been employed to 
overcome this quandary, it’s still possible 
for dubbing to introduce a minor error—
and several dubs could accumulate a one or 
two frame discrepancy between your work-
tape and the EDL time code addresses. 

For these, and other reasons, we strongly 
suggest that you perform step 9, as de-
scribed in “Auto-Assembly of Audio Events 
Using PostConform” on page 10. Only in 
this way can you be sure that your audio 
events are at their proper addresses.

✽ Synchro Arts makes a product called TITAN 
that includes an application called FixSync for 
the purpose of automatically comparing the 
guide track to auto-spotted regions, and mak-
ing any necessary adjustments to the auto-
spotted regions. For more information, see 
their web site at www.synchroarts.com.

Machine Control Basics
PostConform is able to perform the impor-
tant task of auto-loading from source decks 
because of its built-in machine control fea-
tures. Using this feature, PostConform can 
control basic transport functions of many 
different types of video and audio decks.

PostConform supports three formats for 
machine control: Sony 9-pin, V-LAN, and 
Lynx I/II. Via one of these three formats, 
PostConform is able to establish direct, 
frame-accurate control of almost any pro-
fessional and current VTR or ATR.

Sony 9-Pin
Within the video editing suite, CMX may 
dominate the world of EDL formats, but 
Sony dominates the world of transport 
control formats. Sony 9-Pin (also known as 
P-2) refers to the industry-standard DB-9 
multi-pin connector it employs. Impor-
tantly, it also refers to the transport control 
protocol that’s “understood” by Sony pro-
fessional VTRs and ATRs, and compatible 
machines made by other manufacturers. 

With the Sony 9-pin format, Sony’s BVE-se-
ries of video editing systems have been able 
to control most of these decks directly, 
without third-party transport synchroniz-
ers. Due to Sony 9-Pin’s domination of the 
video suite, and the format’s relative sim-
plicity, many other companies now make 
Sony 9-pin-compatible VTRs, DAT decks 
and multitrack ATRs. 

In its basic set-up, PostConform performs 
auto-loading with the help of a cable from 
a Macintosh serial port to the slave deck’s 
9-Pin control port. If you’re working with a 
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Sony 9-Pin compatible VTR or ATR, this 
form of direct 9-Pin control is the simplest 
approach. If you’re already integrating ei-
ther V-LAN or a Lynx synchronizer into 
your system, however, you may choose to 
control your deck through one of these two 
options. 

Videomedia V-LAN
V-LAN, made by Videomedia, is a standard 
for machine control that makes all trans-
ports “look the same” to PostConform. 

V-LAN’s basic concept is simple: 
1. A V-LAN transmitter is connected to 

the Macintosh’s serial port.
2. A V-LAN receiver is connected to the 

remote control port of each V-LAN-
compatible VTR or ATR (almost all 
current professional decks).

This way, PostConform doesn’t care if 
you’re working with ATRs or VTRs with 
wildly different control standards: Post-
Conform thinks it’s seeing one type of ge-
neric “V-LAN” transport, and V-LAN does 
the translation. The V-LAN system knows 
the ballistics and protocol for each of the 
connected transports, and each receiver is 
fitted with the appropriate transport con-
trol cable. 

TimeLine Lynx I and Lynx II
The TimeLine Lynx-series of external trans-
port synchronizers are extremely popular. 
Unlike V-LAN, they are stand-alone sys-
tems that can synchronize decks without a 
computer. They can, however, be con-
trolled by a computer, as with PostCon-
form.

PostConform is compatible with the origi-
nal Lynx I and the second-generation Lynx 
II. This means that anything connected to 
a Lynx-series synchronizer can be con-
trolled by PostConform, to serve as a source 
deck. Lynx modules come pre-pro-
grammed to control a number of ATRs and 
VTRs. Optionally, they can also be con-
nected to other DAWs; the Lynx II can 
even be connected to specialized film 
transports. 

In an ordinary Lynx I or Lynx II setup—
say, with a VTR master and an ATR slave—
each deck requires its own Lynx module. 
The Lynx II system allows you to connect 
up to 32 decks, using just one Lynx module 
per deck (and, of course, cabling between 
each module and its respective deck). Us-
ing front-panel controls, any single deck 
can be configured as the master. 

With PostConform, only one Lynx I or 
Lynx II module is needed for each source 
deck. A cable is connected from the Mac-
intosh’s serial port to the Lynx’s RS-422 
port. Then, with the Lynx in slave mode 
(“on line”), PostConform assumes direct 
control of whatever deck is connected to 
that module. 

System Synchronization
Note that when channels 1 and 2 of your 
audio interface are set to Digital Sync 
mode, your whole system will resolve to 
the digital clock coming in on those in-
puts. This means that your USD or LTC-to-
MTC converter will still be used by Post-
Conform for positional information, but 
not for the clock reference.
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chapter 4

Using PostConform

A Typical PostConform 
Session
PostConform is flexible enough to accom-
modate many different job requirements 
and work styles, but its basic operation is 
going to be the same in most situations. 
Here’s how a typical PostConform session 
progresses: 

1  Import the EDL

2  Load all Source Audio material.

3  Export Pro Tools session. 

Along the way there are many options 
available for tailoring PostConform to the 
needs of your particular project, including 
the ability to set up the Pro Tools session 
by editing PostConform’s “destination 
tracks” and other parameters. All of these 
are explained in this chapter. Before get-
ting to the details of using the program, 
however, its worthwhile to take a few min-
utes to look at the main windows and work 
environments in PostConform. The next 
section, Guided Tour of PostConform will 
help you become familiar with the tools 
you now have at your disposal. 

Guided Tour of 
PostConform
In this section you’ll find a “map” of the 
PostConform application and its main 
windows. 

The EDL Display Window
When PostConform first launches it will 
open to the EDL Display window, shown 
below with an EDL already imported:

The EDL Display shows you the data in the 
imported EDL. You can double-click on a 
statement to view the EDL Event Info win-
dow (or, select a statement and choose 
EDL > EDL Event Info). The EDL Event info 
dialog opens.

EDL Display window (with EDL imported)
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✽ The EDL cannot be edited from within Post-
Conform.

The individual event’s handle times may 
be edited, but they only affect the times of 
the Source element created from the event. 
Therefore, you must change these values 
before creating sources. The Track field sets 
the starting track number in the exported 
Pro Tools session (in the example above, 
the starting track will be track number 1). 
The Comments field can be used as the re-
gion name by turning on the Conforming 
Preference “Use Comments as Region 
Names.” See “Conforming Preferences” on 
page 31 for more information.

Statements can be selected individually or 
in combination from within the EDL Dis-
play window. 

To select EDL statements:

■ Click on a statement line to select a sin-
gle statement. The selected event is high-
lighted, and the Source for the selected 
event is highlighted.

■ Click on a Source to select all the events 
associated with it. 

■ Select multiple contiguous events by 
holding down the Shift key and clicking on 
different events. Select discontiguous 
events by Command-clicking on individ-
ual statement lines.

To display the EDL Event Info window for 
multiple statements, use the Previous and 
Next buttons of the EDL Event Info win-
dow to display each event’s info. 

When more than one event is selected, the 
Previous and Next buttons move through 
the selected events only.

Sources
PostConform looks at the events on a given 
source tape, compares Source In / Source 
Out times, looks at preferences (like Com-
bine if shorter than) and track assignments 
and distills these events into the fewest 
necessary sound files for the session. These 
are called Sources. These sources represent 
the sound files which, when captured, can 
be cut up to create all the events.

EDL Event Info dialog

Selecting Events in the EDL Display Window

Use the Previous/Next button to move between event 
info for multiple events
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For example, if the same sound effect is 
used three times in an EDL, although there 
are three events listed, PostConform can 
determine that only one source needs to be 
created. This source represents the record-
ing of one sound effect off tape to one disk 
file that can be played back three different 
times.

The Source Reels bin lists all the sources as-
sociated with the current session, includ-
ing loaded and unloaded sources. Sources 
that haven't been loaded are listed in ital-
ics. 

Source Info

Double-click on a Source in the bin to dis-
play the Source Info dialog (or, select a 
source and choose Source Audio > Source 
Info).

The Source Info dialog lets you view and 
edit the name of the Source and designate 
input channels. The Start Time, End Time 
and Duration fields are display-only. You 
can select multiple sources in the bin by 
Shift-clicking on successive sources, or by 
Command-clicking to select discontiguous 
sources. When multiple sources are se-
lected you can Command-click on any of 

them to display the Source Info dialog, 
then use the Next button to display the 
Source Info dialog for each source. You can 
also simply double-click on a source, re-
gardless of your selection, then use the Prev 
and Next buttons to view Source Info for 
the previous or next events.

You may arm additional tracks for any 
Source as long as it has not been loaded al-
ready. In this way, you can effectively 
change the number of channels used for 
any given edit in the EDL. 

Recording Status Window
The Recording Status window provides in-
formation about the status of recording 
(i.e., source loading). 

To display the Recording Status window:

1  Choose Windows > Record Status. The 
Record Status window appears.

The top-most field displays the current 
time code location, and this display can be 
toggled to display SMPTE Time Code (with 
a USD), MIDI Time Code (with a LTC-to-
MTC converter), or 9-pin time code via the 
toggle button to the right of the time code 
display. In the example above, the display 
shows 2;41;29;01, in drop-frame format. 

Source Reel Info dialog

Recording Status window
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Above the time code toggle button is a 
small field that displays the time code for-
mat. The Loading field displays the name 
of the source being loaded and the Status 
field displays the step of the process cur-
rently underway—searching, pre-roll, re-
cording, etc.

The buttons below the Loading and Status 
fields include the following:

Pause Lets you pause the loading of the 
current Event. 

Abort Lets you completely stop the loading 
of the current Source and begin loading the 
next one (if one is waiting to be loaded). 
You can also abort loading by typing 
Command+(period).

Abort All Lets you completely stop all the 
loading processes entirely, returning you to 
the EDL Display window. 

If you are displaying the Transport Con-
trols, the Record Status window will also 
contain a set of transport buttons. 

Transport Controls

You can display PostConform’s Transport 
window, which provides machine trans-
port control. If you have a USD, this win-
dow also shows USD setup information. 

✽ Note that when you Show Transport Con-
trols, the Transport Controls are displayed at 
the bottom of the Record Status window.

To show the Transport controls:

■ Choose Options > Show Transport Con-
trols (Command + G).

The functions of the transport buttons are:

Show/Hide USD Setup (USD Only) (Shows 
the USD Setup info, and allows you to 
make changes to it, when the arrow is 
pointing downward.

Eject Ejects the tape from the machine

Rewind Puts the machine in rewind until 
you click Stop or Play

Fast Forward Puts the machine in fast for-
ward until you click Stop or Play

Stop Stops the tape

Play Puts the machine in play mode

▲ Pressing a transport control while loading 
aborts all loading. You must first pause or 
abort the current process in order to use any of 
the transport functions.

Transport Controls (with USD)

Show/Hide
(USD only)

Eject
Fast

Forward

Rewind Stop

Play
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Keyboard Transport Controls

You have limited control over the machine 
transport from your keyboard:
• Use the Spacebar to Play or Stop the 

transport.
• Use the > key to Fast Forward.
• Use the < key to Rewind.

Input Monitor
The Input Monitor window displays the in-
put meters during loading. A record-enable 
LED will light below a track that is record-
enabled. The meters indicate clipping with 
a red light at the top of the meter. 

You can clear a clipped meter by clicking 
on it. Option-click to clear all clipped 
meters.

To display the Input Monitor window:

■ Choose Input Monitor from the Window 
menu. The Input Monitor window appears:

Track Mapping
The Track Mapping dialog is where you set 
up the destination input on your audio in-
terface for each channel of source audio. 
Individual events may have their destina-
tion set in the EDL Event Info dialog de-
scribed earlier. 

To display the Track Mapping dialog:

■ Choose Options > Track Mapping.

Input Monitor

clipped input
(clear by clicking)

Track Mapping dialog
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The abbreviations for source tracks are con-
sistent in all the supported EDL formats, 
and they are as follows:

Use the Track Mapping dialog to make sure 
each source audio channel is routed to an 
appropriate Pro Tools audio interface input 
by entering the input number next to the 
source audio channel abbreviation. 

Time Code Setup
The Time Code Setup command is used to 
pre-configure the frame rate and session 
start time for the Pro Tools session that 
PostConform will create. Normally, the 
frame rate will be imported from the EDL’s 
FCM statement. You can use this dialog to 
correct the frame rate if it was wrong in the 
EDL, or to set the frame rate if the EDL 
lacked an FCM statement. 

To configure Time Code Setup:

1  Choose Setups > Time Code. The follow-
ing dialog appears:

2  Select the appropriate frame rate. You 
will be warned of the possible implications 
in changing the time code format once an 
EDL has been imported. In the example 
above, the Pro Tools session will be created 
with 29.97 non-drop FPS time code. 

3  Enter a session start time. This will pre-
configure the Pro Tools session to start at 
the desired SMPTE start time. To enter time 
values into the Pro Tools Session Start field 
simply begin typing the desired value. The 
field will fill from right to left with your en-
try for hours, minutes, seconds and frames. 
You should type a “leading zero” before 
single-digit values (i.e., one hour should be 
entered as 01). PostConform will insert the 
colon or semi-colon between each pair of 
digits. 

4  If you are using Pull Up or Pull Down, se-
lect this option.

5  Click OK. 

Abbreviations for Source Tracks

Abbreviation Track

V Video only

A: Audio 1 only

A2: Audio 2 only

B Audio 1 and Video

A2/V Audio 2 and Video

AA Audio 1 and 2

AA/V Audio 1, 2 and Video

[none] some combination of audio 3 
and 4, as described by the suc-
ceeding AUD statement.

Time Code Setup dialog
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Preferences
The Preferences dialog lets you set a num-
ber of defaults for PostConform. 

To display the Preferences dialog:

■ Choose Options > Preferences. The Pref-
erences dialog will appear. This dialog has 
three pages that allow you to configure 
Loading, Conforming, and EDL Display 
preferences separately.

The values you set in the Preferences dialog 
will be applied automatically to each new 
PostConform session you create. 

Loading Preferences

Abort loads after _ attempts

This setting tells PostConform how many 
“retries” it should attempt before giving up 
on loading a Source and proceeding to the 
next one. Select this Preference, then enter 
enter a value in the box to define how 
many retries to attempt. 

Don’t prompt to locate tape for manual loads

This preference tells PostConform to sim-
ply wait for the time code value to come up 
for the next source element, rather than 
asking the user to locate the tape and wait-
ing for them to do so. It allows you to leave 
the room and let a tape just play through.

Don’t warn for time code format mismatch

This setting prevents a warning dialog from 
being posted if there is a time code format 
mismatch between the EDL and the source 
tapes. If a time code is mismatched, and 
you continue loading, you may end up 
with incorrect results.

Conforming Preferences

Handle Size 

This preference tells PostConform to record 
extra audio, specified by number of frames, 
at the head and tail of each event, starting 
before the Start Time by the Head Handle 
length, and ending after the End Time by 
the Tail Handle length. 

Adding handles allows flexibility when 
working with the regions later in Pro Tools, 
as regions can be “trimmed out” beyond 
their beginning and end boundaries.

Individual Handle sizes may be set for each 
event in the EDL Event Info dialog ex-
plained earlier in this chapter. The default 
value for both is 150 frames (5 seconds @ 
30 FPS). 

Preferences dialog (Loading page)
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Handles, Machine Pre-Roll, and 
Discontinuous Time Code (Warning!)

Be careful with handle settings, machine 
pre-roll, and tapes with discontinuous time 
code. If your handle size is 150 frames, and 
your machine pre-roll is 150 frames, you 
need to have 10 seconds (at 30 FPS) of con-
tinuous time code recorded on tape before 
the event you are attempting to capture. 
Since this is not always the case with pro-
duction sound, you may have to adjust 
handle and machine pre-roll settings ac-
cording to your project’s parameters.

Load Spacing

This preference can increase the efficiency 
of the loading process. In essence, it tells 
PostConform to refer to the entered 
amount of Load Spacing when determin-
ing whether two events should be incorpo-
rated into the same Source, and therefore 
recorded to separate soundfiles or captured 
as a single sound file to disk (note that this 
will not affect regions that are created from 
the sound file). 

With a 30 second Load Spacing setting, two 
events will be recorded to separate sound-
files if there is larger than a 30 second gap 
between the End time of the first event and 
the Start time of the next event. If the gap 
between these two points is less than 30 
seconds, PostConform will incorporate 
both events into the same Source and 
therefore record both events to a single 
sound file. 

Delimiter Character for Tracks

This preference lets you set a character de-
limiter to distinguish the sound file names 
of successive regions in each Track. 

Delimiter Character for Sources

Similar to the Track Delimiter option, De-
limiter Character for Sources lets you spec-
ify a character delimiter to distinguish each 
Source element within/from the same 
Source reel. 

Use Comments as Region Names 

This option lets you control how Pro Tools 
names regions in the session. With this op-
tion checked, Region name will be the con-
tents of the Comments field, appended 
with the track number. With this option 
unchecked, a Region will be named accord-
ing to its Event Number, with the track 
number and a unique identifier appended 
to it. 

Open Session in Pro Tools on Export

With this option checked, Pro Tools will 
automatically launch and open the current 
exported Pro Tools session when the Ex-
port Pro Tools Session command is chosen 
from PostConform’s File menu. 

Create Sources Automatically on Import

This setting instructs PostConform to in-
terpret the information in the EDL when it 
is imported and automatically create ap-
propriate Sources. (Turning this Preference 
On before importing an EDL has the same 
result as selecting all EDL events and 
choosing Create Sources menu command.)
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EDL Display Preferences

Strip from Comments

This instructs PostConform to strip the text 
you specify from the EDL Display.

Do Not Display these Statement Types

The options under this heading are pro-
vided to let you customize the EDL Display 
window. By checking any of these options, 
you can choose to avoid displaying the fol-
lowing EDL elements:

Video Only Edits

Based on the information in the EDL’s 
Channel column, if an event is a Video-
only edit it will not be displayed in 
PostConform’s EDL window when this op-
tion is checked. 

Zero Length Edits

If the duration of an Event is 0, it will not 
be displayed when this option is checked. 

Using PostConform
PostConform is flexible enough to accom-
modate many different job requirements 
and work styles, and provides two basic 
modes of operation, one for when you 
have both the EDL and all source au-
dio/tapes ready before you begin, and one 
mode for those times when you want to 
pre-load the source tapes while waiting for 
the EDL. 

In the first mode (referred to as normal 
mode conforming) the imported EDL 
drives the whole operation, creating source 
definitions in PostConform, prompting 
you to insert each source tape as needed, 
locating the external machines to the ap-
propriate source in/out addresses, arming 
the appropriate Pro Tools tracks and re-
cording all source audio to disk. Again, this 
mode is primarily for post facilities who are 
fortunate enough to get the EDL and all 
source tapes simultaneously. It does re-
quire, however, that each individual tape 
be loaded as necessary (i.e., as needed by 
the EDL). It speeds up the process by only 
loading the audio material needed for the 
finished show (plus handles). 

When this is not the case, PostConform 
provides ways for you to pre-load source 
audio. This second mode (referred to as 
pre-loading) lets you have all your source 
audio loaded to hard disk and ready to be 
conformed to the EDL. Once the EDL is im-
ported, all sources are linked to the EDL 
events. After you Export a Pro Tools session 
the conform process is complete. 

Here’s how a typical PostConform session 
progresses in each of these modes. 
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Method 1 — Normal Mode 
Conforming

To conform in Normal Mode:

1  Receive the EDL and tapes before begin-
ning.

2  Create a new PostConform session

3  Import the EDL into PostConform. 

4  Make new Sources in PostConform auto-
matically via the “Create Sources on Im-
port” Preference, or manually using the 
Create Sources command. If you set Post-
Conform to automatically create sources 
on import, then your events will automati-
cally be “linked” to the appropriate 
sources. 

5  If necessary, change source input assign-
ments, configure checkerboarding, and 
configure other loading settings. 

6  Load Sources (Command + L) and let 
PostConform begin loading audio from the 
source reels onto hard disk.

7  Once you’ve loaded source audio you can 
set destination tracks for the soon-to-be-
created Pro Tools session, if necessary. 

8  Export the PostConform session to 
Pro Tools using the Export Pro Tools Ses-
sion command. Once this is completed, 
open the Pro Tools session and check sync.

9  If necessary, go back to PostConform to 
load additional events. Conform any addi-
tional events by spotting them to the exist-
ing Pro Tools session using the Spot to 
Pro Tools command.

Method 2 — Pre-Loading 
Sources Prior to Receiving EDL
This method lets you create source defini-
tions in PostConform without importing 
an EDL first. These source definitions then 
drive the loading process, prompting you 
to insert each source reel as needed. Once 
the sources and source audio have been 
loaded, the EDL can be imported and the 
EDL events must be linked to their appro-
priate source reels. 

Many production sound recordists now 
record sound to disk, often as SDII files, 
with devices such as the DEVA. These takes 
are often delivered directly to the sound ed-
itor on CD-ROM. If all the time-stamped 
takes are delivered to you on disk, all you 
have to do is point PostConform to these 
files, by linking events, and you're done.

To pre-load sources:

1  In PostConform, create new Sources (via 
the New Source command).

2  Load Sources (Command + L) to load 
audio from the tapes to disk.

3  Import the EDL (Command + H). 

4  Link Events to Sources (Command + K). 

5  Export Pro Tools session

▲ This method usually requires a lot more 
disk space than normal mode conforming, due 
to the fact that entire reels are recorded, which 
is usually more audio than the EDL requires. 
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Loading Paradigms
When loading source audio into 
PostConform there are several Preference 
settings that control how “automated” the 
loading process itself will proceed. If you 
are loading your source audio from a ma-
chine-controllable deck, you can configure 
PostConform to run in fully-automated or 
semi-automated mode. 

The difference between the two modes is 
whether or not PostConform halts loading 
at time code mismatch or “skips” sources 
that it can not locate and proceeds to the 
next one until it’s finished. If your source 
audio is not on a machine-controllable 
deck, you can load sources manually in ei-
ther semi-automated mode or fully manual 
mode. Semi-automated loading will 
prompt you for each source reel and then 
automatically punch in and out as neces-
sary until all statements are loaded from 
that source. In fully manual mode, 
PostConform prompts you to cue the 
source deck.

Machine Controlled Loading

Fully Automated This mode could also be 
called “unsupervised” mode. When config-
ured for fully automated machine con-
trolled loading, PostConform does not halt 
the loading process when it encounters an 
unloadable statement. Instead, it retries a 
user-definable number of times, after 
which it “gives up” and moves on to the 
next statement. To set up PostConform for 
this mode, configure the Preference option 
Abort after X tries and set X to the number 
of retries you want. 

Semi-Automated In this mode, if PostCon-
form has a problem attempting to load a 
source element it will halt all loading and 
post a warning dialog.

No loading can take place until you either 
fix the problem and click Retry to tell 
PostConform try to load the statement 
again, or click Abort to tell PostConform to 
skip that event. If you wish to completely 
stop the entire loading process click Abort 
All. To configure PostConform for this 
mode, turn off the Preference Abort Load 
after _ Attempts. 

Manual Loading

Manual loading refers to situations when 
you can not rely on machine control to cue 
up your source deck. Here’s two different 
ways to work in manual loading mode:

Semi-Automated In this mode, PostCon-
form does everything but fast-forward the 
deck to the next statement automatically. 
To configure PostConform for this mode, 
turn on the Preferences for “Don’t prompt 
to locate tape for manual loads” and “Abort 
loads after _ attempts,” and enter 0 for the 
number of retries. Turning on the “Don’t 
prompt to locate tape for manual loads” 
Preference tells PostConform that you’re 
going to load the source tape(s) and let 
them run from start to finish, letting Post-
Conform punch in and out of record for 
each source element as they are encoun-
tered. The only disadvantage to this 
method is that it can take considerably 
longer for each source to be loaded as Post-
Conform can not fast-forward without ma-
chine control. “Abort After 0 Retries” 
makes sure that PostConform will not stop 
during the tape loading process—since 
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there is no machine control available in 
this scenario, PostConform has no way of 
rewinding the source deck to attempt a re-
try. 

Fully Manual In this mode, you manually 
cue your machine(s) to the appropriate 
time code location and then let PostCon-
form punch in and out once there. To con-
figure PostConform for this mode, simply 
turn off the Preference “Don’t prompt to 
locate tape for manual loads.” This 
method, while requiring you to shuttle 
tapes to their appropriate Source In loca-
tions, can reduce the overall amount of 
loading time required in non-machine 
controlled situations. 

Normal Mode Conforming
The first mode we’ll look at is normal mode 
conforming. In this mode, PostConform is 
used in the most automated way possible. 
This mode begins by importing an EDL. 

Importing EDLs
Importing the EDL is the first step in the 
autoconform process. Assuming you have a 
CMX format EDL on your Macintosh, on a 
DOS or Macintosh format floppy disk, or 
on a CD-ROM, you can go ahead and im-
port the EDL into PostConform. 

To import an EDL:

1  If you have not already done so, launch 
PostConform and create a new PostCon-
form session by choosing File > New. Select 
the bit depth for the session (16 or 24), 
then click OK. Make sure you have config-
ured PostConform’s Peripherals, Machine 
Control and Hardware Setup dialogs as de-
scribed in Chapter 2: PostConform Installa-
tion and Setup. 

2  Choose File > Import EDL. 

3  Locate and open the EDL that you want 
to import into PostConform. 

4  The EDL Display Window displays the 
EDL and all the events (audio and video 
clips) in it. At this point, you have a num-
ber of options for sorting the elements to 
help organize the task of creating sources 
and laying out the Pro Tools session. 

Creating Sources on Import

PostConform can create source reel defini-
tions automatically while importing an 
EDL. This not only derives the source defi-
nition from the EDL but also links events to 
sources automatically. Linking events to 
sources is also automatic when you utilize 
the Create Sources command on events, 
which you do if you accidentally imported 
an EDL with the Create Sources On Import 
Preference turned off. See “Creating 
Sources after Importing the EDL” on 
page 37. 
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To have PostConform create sources on 
import:

1  Choose Preferences from the Options 
menu. The Preferences dialog appears.

2  Select the Preference “Create Sources on 
Import.” 

3  Click OK when you are done.

4  Use the Import EDL command (Com-
mand + H) to import the desired EDL. 
PostConform will use the information in 
the various EDL statements to create source 
reel definitions that are associated with 
each EDL event based on the Load Spacing 
setting in the Preferences dialog. These 
sources will appear in the Source Bin when 
the import is completed. 

✽ If you import an EDL but forgot to turn on 
the preference “Create Sources On Import,” 
use the Select All Events and Create Sources 
commands to achieve the same results. This 
process is explained in the next section.

Creating Sources after Importing the 
EDL

If you selected the preference “Create 
Sources Automatically on Import” before 
importing the EDL, then PostConform will 
already have created and linked the neces-
sary sources, which will be listed in the 
Source bin. If you do not have this option 
checked in the Preferences dialog, you’ll 
need to use the Create Sources command to 
create sources for the events in the EDL. 

To create sources for events:

1  Configure the Load Spacing and Handle 
Size Preferences as necessary.

2  Highlight all the events in the EDL Dis-
play window by choosing EDL > Select All 
Events (or press Command + A). Or, use 
any of the various selection options of the 
EDL menu to select certain types of events 
(Select Unloaded Events, Select Unlinked 
Events, or Select All Events). 

3  Choose EDL > Create Sources 
(Command + Y) to make PostConform cre-
ate sources from the information in the 
EDL statements. 

Because the links are created automatically 
when you use the Create Sources com-
mand, these new sources will show up in 
the Source bin in non-italicized text. 

All events that do not have a source will be 
listed in italics in the EDL Display window. 
All events and sources that are not loaded 
will have an empty checkbox next to them. 
As they are loaded, this box is filled in. 

Before you start loading sources you may 
want to sort the EDL to facilitate a more ef-
ficient loading process. The next section 
explains PostConform’s EDL sorting op-
tions. 

Sorting the EDL
PostConform lets you sort an EDL in any of 
three different ways. Use the Sort options 
to organize the order in that sources are 
loaded. 

Here’s a brief example of when the sort 
modes are useful. There may be a situation 
where you want to conform only the first 
scene of a show found on reels 1 and 2. You 
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could sort the EDL based on Reel name and 
Show Order (B mode), and then select only 
the Scene 1 events from Reels 1 and 2 and 
only create sources from those events. 

The sorting options, described below, can 
be selected from the Options menu:

A Mode Sort:  A Mode shows the elements 
in the order in that they were imported. 

B Mode Sort:  B Mode sorts the EDL by 
Source Name and Show Order (Record In 
time).

C Mode Sort:  C Mode sorts the EDL by 
Source Name and Source Order (Source In 
time). 

✽ EDLs are sometimes already sorted when 
an audio editor gets them, therefore the “orig-
inal” order could be B or C mode sorted. A 
mode is Show order, or the order that the pro-
gram will run. 

To sort the EDL:

■ Choose Options > (preferred sort mode). 
The statements will be re-ordered in the 
EDL Display window appropriately. 

Once the EDL is imported and sorted to 
your liking, you’re ready to create sources 
(if necessary) and load sources. 

Loading Sources
With sources created from EDL Events, 
you’re ready to start loading audio from the 
source reels onto disk. (Make sure you have 
all the necessary reels before proceeding.) 

To load source audio:

1  Check the Options menu to make sure 
that Machine Enabled has a checkmark 
next to it, indicating that machine control 
is enabled. 

2  Check to make sure Active in Back-
ground has a checkmark next to it so that 
PostConform will be able to load audio in 
the background. 

▲ If Pro Tools is also running, do NOT set 
PostConform to Active in Background mode. 

3  Select all the sources that you want to 
load in the Source bin by single-clicking 
them. All the Events associated with the se-
lected source(s) will be highlighted in the 
EDL display window. 

4  Choose Source Audio > Load Sources 
(Command + L). PostConform will begin 
prompting you to insert each source tape as 
they are needed. 

If Machine Enabled is not checked, the In-
sert Tape dialog will also prompt you to cue 
up the tape and start it playing. 

Sort Modes on the Options menu

Sort modes

Insert Tape dialog
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5  Locate and insert the requested reel and 
click OK. If you insert the wrong reel (more 
specifically, a reel with “wrong” time val-
ues) PostConform will post a warning dia-
log box because it won’t be able to find the 
start time it is looking for. 

There are two possible situations where 
you will not be warned. 

◆ If you’ve configured your Preferences to 
not display warnings (by turning off the 
Abort loading after _ attempts option) you 
will NOT see a warning dialog box. 

◆ If you’ve inserted the wrong reel but it 
has the same time code range as the re-
quested reel. In other words, you have dif-
ferent source tapes with non-unique time 
code values. To avoid this situation, most 
facilities start each reel at a new SMPTE 
hour, i.e., reel 1 will start at 01:00:00:00, 
reel 2 at 02:00:00:00 etc. If this is not the 
case (say for example all reels start at 
01:00:00:00) you can end up with com-
pletely wrong audio in your Pro Tools ses-
sion. 

After you initiate loading, PostConform 
will locate the source reel to the first 
source’s Start Time (minus the pre-roll 
amount) and record the take. Handles are 
applied while creating source elements 
from EDL events. When the reel reaches 
the source’s End Time (plus post-roll 
amount) it stops recording and saves the 
file to hard disk. You may enter many 
Sources into the load list. When 
PostConform finishes with a reel, it will 
prompt you for the next one until all pend-
ing Sources are loaded. 

Once you’ve loaded all your source mate-
rial you’re ready to start the conforming 
process. The next section will explain this 
aspect of PostConform. 

Conforming
After PostConform has loaded all the 
source audio you simply export a Pro Tools 
session from the PostConform session. 

Before doing this final step, however, you 
should first set up the “layout” of the 
Pro Tools session. 

To set up the layout of the Pro Tools session:

1  Select an event or events in the EDL Dis-
play window. 

2  Choose Set Destination Tracks from the 
EDL menu. The Set Destination Tracks dia-
log appears:

3  Enter the track number for the First and 
Last record destination tracks that a given 
event will be recorded to. 

4  Check the option for Checkerboard to al-
ternate over the range of tracks. 

▲ Checkerboarding happens automatically 
over the range of tracks you select. However, it 
is still possible for events to overlap on a track 
if you do not specify enough tracks, and there 
are many overlapping events in the list.

Set Destination Tracks dialog
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To configure the time code format and start 
frame:

1  Choose Setups > Time Code. The follow-
ing dialog appears

2  Enter a Session Start. This will preconfig-
ure the Pro Tools session to start at the de-
sired SMPTE start time. To enter a value in 
the Session Start field, begin typing the 
start time value with your keypad. Enter 
your time values with leading zeroes (in 
other words, enter 1 hour as 01, 5 minutes 
as 05, etc.). PostConform automatically 
fills in the delimiter characters. 

3  Click OK. 

To conform your session:

1  Choose File > Export Pro Tools Session. A 
dialog will appear asking you to name the 
Pro Tools session and indicate where you 
want it saved.

2  If you turned On the Preference Open 
Session in Pro Tools on Export, 
PostConform will automatically launch 
Pro Tools and have it open the new session. 
If not, you can quit out of PostConform 
and then open the new Pro Tools session in 
Pro Tools.

3  If you check sync in the new Pro Tools 
session and find problematic regions, you 
may delete them, return to PostConform, 
re-load the questionable material and then 
use Spot to Pro Tools. 

Pre-Loading Mode
As mentioned earlier, PostConform lets 
you pre-load source tapes first and then im-
port and conform the audio to an EDL 
later. 

This method involves creating source defi-
nitions in PostConform and letting those 
sources “drive” the loading of audio. After 
the audio is recorded to disk you then im-
port the EDL into PostConform, link the 
EDL and Sources to the sound files on disk 
and then export a Pro Tools session. 

Here’s how this method would progress...

To load sources before you have received an 
EDL:

1  Collect the Source Tapes you’ll be con-
forming. 

2  Create a new PostConform document. 

3  Choose Source Audio > New Source 
(Command + T) to define each of the 
sources (or takes) on each source reel.

4  Use the Load Sources command to record 
the audio from each source reel to disk. 
PostConform will prompt you to insert the 
reel for each Source you created, then cue 
up the machine and record the source to 
disk based on the Start/End times and dura-
tion you entered. PostConform will alert 
you if the time code definitions of the 
source reels do not match those of the 
sound files. You can tell PostConform to 
not display warnings via the Preferences di-

Time Code Setup dialog
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alog. In addition, you can tell PostConform 
how many times you want it to retry load-
ing an event before warning you or moving 
on to the next event. Refer to the section 
Loading Paradigms earlier in this chapter 
for more information on how to configure 
these options. 

5  When you receive the EDL, import it into 
the same PostConform document (make 
sure that the Preference to create sources 
on import is turned off). 

6  Next, associate the EDL events to the ap-
propriate source item or element. To do 
this, begin by sorting (if necessary) and 
then selecting all the events from one reel, 
then select that source in the Source bin 
and choose Link Events to Sources from the 
Source Audio menu. This will link the 
events in the EDL to the appropriate 
sources in the bin that are already linked to 
the soundfiles recorded to disk. 

7  Choose File > Export Pro Tools Session to 
create the conformed session. 

Recording Source Audio in Pro Tools 
First

Although not the most practical way to 
work, it is possible to record source audio 
into Pro Tools first and time stamp the 
sound files so that they can be linked and 
conformed by PostConform. If you wanted 
to use this method to manually load source 
audio, you would do the following:

1  Launch Pro Tools and create a new ses-
sion. Create as many audio tracks as neces-
sary.

2  Put Pro Tools online. 

3  Record all your source audio directly into 
Pro Tools. 

4  After you’ve recorded all your sources to 
disk, select all files in Pro Tools’ Region Bin 
and choose Export Selected from the Re-
gion List menu. This ensures that the time 
stamp information is written into the 
sound files and will be available to Post-
Conform.

Assuming you recorded into Pro Tools 
while online, you must first select your 
source sound files in Pro Tools and choose 
the Export Selected command in order for 
each sound file’s time stamp information 
to be readable by PostConform. If you did 
not record on-line the sound files will not 
yet have any time stamp information, in 
which case you will need to select all sound 
files and select the Time Stamp Selected 
command, then use the Export Selected 
command. 

5  Launch PostConform and create a new 
document. If you have already received the 
EDL, you should configure PostConform to 
create sources on import (Preferences dia-
log) and import the EDL. If you have al-
ready imported the EDL but did not have 
this Preference turned on, select all the 
Events in the EDL Display and choose EDL 
> Create Sources (Command + Y). 

6   If you do not yet have the EDL you can 
create sources manually by choosing 
Source Audio > New Source 
(Command + T). 
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7  You should now have the EDL imported 
into your PostConform document, with 
source reels defined in the source bin and 
the audio already recording to hard disk. 
Now you must select each reel’s sources in 
the bin and choose Source Audio > Link 
Sources to Files (Command + F) to link the 
sources to the sound files. You can, of 
course, use any sound file you have on your 
hard disk but the time stamp values must 
match up between the sound file and the 
sources.

8  Once all the sources are linked to sound 
files, choose File > Export Pro Tools Session 
and PostConform begins autoconforming 
your session. 

▲ Do to use Pro Tools and PostConform simul-
taneously while either one is set for “Active in 
Background.” This mode of operation is not 
supported. Switching out of one application to 
the other in this scenario can cause DAE er-
rors.

Reconforming
Another common situation is when you 
are required to “reconform” a session to a 
new, updated EDL. 

To reconform a session:

1  Create a new PostConform session.

2  Import the new EDL. 

3  Use Link Sources to Soundfiles to utilize 
the previously loaded audio. 

4  Load in any new audio that may be nec-
essary.

5  Export a new Pro Tools session. 

Spotting Manually from 
PostConform to Pro Tools
You can run Pro Tools and PostConform at 
the same time, and manually spot Events 
from PostConform to Pro Tools. 

To spot manually to Pro Tools from 
PostConform, with both applications running:

1  Launch Pro Tools and Open a session or 
create a new session.

2  Make sure Operations > Active in Back-
ground is not selected (checked).

3  Launch PostConform.

4  Make sure Options > Active in Back-
ground is not selected (checked).

5  Open a PostConform session.

6  Select Events in PostConform that you 
want to spot to the Pro Tools session.

7  Choose EDL > Spot to Pro Tools.

Events are spotted to the open Pro Tools 
session.

Troubleshooting 
PostConform
This section lists several potential problems 
you may encounter with PostConform.

Problems Getting the Machine to 
Respond

If you use the Transport controls and the 
machine does not respond, then it may not 
be in remote mode, or the synchronizer 
may not be Online. Check these settings on 
your devices and try again. 
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Problems with Synchronization

If you open up the Pro Tools session after 
loading some sources and exporting a ses-
sion, and the regions do not seem to syn-
chronize to the edited master, there are sev-
eral possible issues:

◆ Is the region in the right place according 
to the EDL? Check this by selecting it in the 
region bin, and showing the start and end 
times. Do these match the EDL? If not then 
some of the likely causes for this are:

◆ Does there seem to be a problem with the 
session offset? You may be able to correct 
this by slipping all the regions in the ses-
sion by adjusting the Time Code Setup Ses-
sion Start Time. Make sure to select the 
“Maintain Relative Timing” option at the 
prompt. This will slip all regions against 
the master time base.

◆ Could there be a problem with the ses-
sion time code format? Make sure that the 
time code format of the Pro Tools session 
matches the time frame format in the EDL. 
The EDL gives the Show Time, or Master 
Frame Format in the first FCM statement 
right after the Title statement. It should say 
either:

◆ FCM: Non-Drop Frame, or
• FCM: Drop Frame

If there’s no FCM statement after the title, 
the time code format is assumed to be PAL 
(25 FPS). Use a text editor to open the EDL 
and check or modify these statements as 
necessary.

◆ If the region is in the right place, then is 
the audio for the region correct? This will 
be obvious when you try to sync to the 
master. A likely cause for this problem here 
is Source Frame format mismatching. 

Again, the FCM statement defines the time 
code format for the Sources, but if the time 
code format does not match the rest of the 
sources, then a special FCM statement will 
precede the events whose sources have the 
different format. The time code format 
must be switched back again after those 
statements, so there will be another FCM 
afterwards. In PostConform, Drop Frame 
time code values are shown with semi-co-
lons, rather than colons between the 
Hours;Minutes;Seconds;Frames fields.

◆ The time code format may be wrong. In 
this case, there’s not much you can do, un-
less you can generate an EDL that matches 
the source audio tapes. PostConform will 
not do this.

Most time code synchronizable DAT decks 
(the Sony 7030, the Otari DTC 90, and the 
Tascam DA-60) can display and generate a 
different time code than is printed on the 
tape. Consult the documentation for your 
deck to make sure the time code that is read 
matches the time code recorded on tape.
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appendix a

Glossary of Terms

A/B Roll Editing Involves two source decks 
and one master. This allows for simulta-
neous edits such as dissolves. Compare 
with cuts-only editing.

Address An event-specific time code refer-
ence, such as a source in time, or record out 
time.

ADR Automated Dialog Replacement; used 
to replace or provide dialog for visual 
scenes that have already been shot. Talent 
(actors) typically watch a screen and over-
dub their lines, attempting to match the 
new audio takes with the existing visuals as 
closely as possible.

ATR Audio Tape Recorder, of any format, 
including a Digital Audio Tape (DAT) deck.

AUD A code in a CMX 3600-format EDL 
that refers to the presence of audio channel 
3 and/or audio channel 4. 

Audio Post Production The process of add-
ing dialog, music, sound effects, and other 
audio to video or film. The “post” reference 
comes from the fast that these elements are 
added once the film or video has already 
been shot. 

Auto-Assembly In audio post production, 
auto-assembly is the integration of EDL im-
porting, autoconform, and autoloading via 
machine control. With it, an operator can 

(theoretically) load up source reels of tape, 
and then sit back while the events are auto-
matically recorded from source reels onto 
the DAW’s hard drive. Once recorded as 
the audio files, the files are autoconformed 
to the record in and out times on the EDL, 
to become regions within an audio session. 

Autoconform An automated process of con-
forming source events, that have been 
loaded onto a DAW’s hard drives, to the 
record in and out times of an imported 
EDL. Autoconform, technically speaking, is 
the process of conforming audio regions to 
EDL times, and doesn’t necessarily refer to 
anything regarding machine control.

Autoloading One step in the process of 
auto-assembly. Autoloading refers to the 
physical process of loading source material 
into a DAW while the source machine(s) is 
machine controlled by the DAW. In its 
proper implementation, as implemented 
by PostConform, autoloading includes full 
control of the source machine, and auto-
matic arming of DAW tracks. 

BVE Prefix for the popular Sony BVE-series 
of video editors. 

BVU Prefix for the popular Sony BVU-series 
of VTRs.
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Center-Track Time Code Refers to a varia-
tion of a 2-track, open-reel analog tape for-
mat, which inserts a small track for time 
code information between the left and 
right channels. Used only with the “half-
track” tape format, in which the left and 
right channels each take up approximately 
half the tape’s width. Still common in 
audio post production for video and film.

Channel In PostConform, this refers to the 
source audio or video channel, as associ-
ated with most EDL events. Some EDLs re-
fer to these as tracks; with PostConform, 
however, we call them channels, so as not 
to confuse ourselves with defined destina-
tion tracks, for use with Pro Tools or Post-
View.

Checkerboarding With PostConform and 
other auto-assembly capable DAWs, this re-
fers to the ability to allocate overlapping 
audio events to alternating Pro Tools or 
PostView tracks. In video post production, 
checkerboarding can also refer to the pro-
cess of assembling a video master tape in a 
random fashion—where the edits are as-
sembled to the master tape out of order, for 
maximum efficiency.

Circled Takes Events on a cue sheet or 
printed EDL that have been circled by a di-
rector or editor, to indicate events are de-
sired.

Conforming The process of matching audio 
events with events on a cue list or EDL. 
This can be done manually, where the op-
erator types in times from an EDL, or auto-
matically by the DAW. 

CMX A now-defunct company that inno-
vated in several aspects of electronic video. 
Several CMX EDL formats have become de 

facto standards in audio post production, 
in particular, the CMX 3600 and 3400 for-
mats.

Cuts-Only Editing The simplest form of 
video editing, which requires only one 
source deck, plus a master deck. Refers to 
the fact that “butt-splice” cuts are the only 
type of edit possible; for dissolves or other 
effects that require overlapping source ma-
terial, an A/B roll editing system is re-
quired.

DAW A digital audio workstation, such as 
Pro Tools.

Destination In and Out See record in and out. 

Drop-Frame Refers to a variance of SMPTE 
time code that omits two frames every 
minute except for every tenth minute. 
Serves to compensate for the fact that 
29.97 frame-rate time code runs “slow” by 
3.6 seconds every hour compared to a 30 
frame-per-second timing reference; that is, 
“one hour” of 29.97 non-drop time code is 
equal to one hour and 3.6 seconds of real 
time, due to the fact that the slower frame 
rate does not match “wall clock.” Drop-
ping, or skipping, frame addresses allows 
this format to “jump ahead,” in order to 
maintain a true relationship between the 
time code and “real time,” so that one hour 
of 29.97 drop-fame lasts exactly one hour 
of real time. 

Duration The length, in seconds, of an 
event’s effect (such as a dissolve), as indi-
cated on an EDL.

Edit Decision List (EDL) An Edit Decision 
List is a list of edits, or events, described by 
source in and out times, source reel num-
ber, and record in and out times. It can be 
as simple as a piece of paper or a text file on 
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a disk. The most common electronic EDL 
formats are by CMX. Alternate formats are 
from Grass Valley, Sony, Ampex, and other 
manufacturers. Most editing systems can 
export EDLs to a floppy disk; post-savvy 
DAWs are then able to read, or import the 
data on the floppy. Depending upon the 
system, EDLs can be on a DOS, Mac, or 
other format diskette. 

EDL Export The method by which DAWs 
and video editing systems output EDLs, 
typically to a floppy disk. Many editing sys-
tems are able to export an EDL in CMX EDL 
format.

EDL Import The method by which DAWs 
and video editing systems read and “under-
stand” an electronic EDL, typically from a 
floppy disk. Depending upon the EDL for-
mat and the CPU being used to read the 
disk, and whatever optional EDL importing 
programs may be in use, the disk can either 
be read directly, can be read as a text file, or 
can be converted from one format to an-
other—such as from DOS to Macintosh. 

Emulator This is a stand-alone device that is 
programmed with a particular machine’s 
transport protocol and ballistics. Typically, 
emulators make various audio and video 
transports look like an industry standard 
video deck (such as the Sony BVU-800-se-
ries), to a video editing system, a transport 
synchronizer, or a machine controller 
(such as a DAW). In this way, the DAW or 
synchronizer need be programmed only to 
operate one type of external transport, 
with the emulators making the translation. 

Event From the lingo of video post produc-
tion, an event is an individual edit, GPI 
trigger, or other time code-specific occur-
rence. EDLs describe events line-by-line.

Frame Code Mode (FCM) An EDL indica-
tion of whether the time code is drop-
frame or non-drop-frame. This can also in-
dicate if the EDL is at 25 FPS.

GPI/GPI Trigger Stands for General Purpose 
Interface. Professional video editing sys-
tems, offer contact-closure-style switches 
(in addition to machine control), which 
can be custom-wired to start and stop de-
vices such as video character generators, 
digital effects generators, audio cart ma-
chines, slide projectors, etc. During EDL 
importing, most audio post operators will 
choose to delete GPI and video edit infor-
mation from the EDL, though this infor-
mation can be sometimes useful.

Guide Track The guide track typically con-
tains “raw” and unprocessed audio ele-
ments that the picture editor wants to in-
clude, such as dialogue that was recorded 
on location. Since it is assumed to be in 
sync with the video, the guide track is used 
in two ways. First of all, processed dialogue 
and other elements can be matched up vi-
sually, comparing the waveforms of the 
guide track with that of the new regions. 
Secondly, new regions can be compared 
audibly with the guide track; this way, par-
ticularly for dialogue, it is possible to hear 
“phasing” mismatches when the sync is 
not quite right.

Handle A user-definable amount of time 
that precedes or follows a source’s actual 
source in or source out times. Audio post-
production engineers often like to have 
this additional information for a variety of 
reasons, but the main reason is to fix up 
bad edits. For example, a line of up-cut di-
alogue (that is clipped short) can be 
trimmed outward to fix the problem. 
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PostConform allows the user to define a 
preset amount of handle time, or select 
none at all, for PostConform’s autoloading 
of source sounds.

LTC Longitudinal Time Code. Resides on 
linear tracks, such as an audio track or the 
control track of a video tape. Is recorded 
and played back much like an audio track. 
Cannot be read off of tape while the tape is 
“crawling” at a very slow speed, or is 
paused or stopped. Also requires a wide-
band time code reader if sync is required in 
fast-winds or slower speed.

Lynx (Lynx-I, Lynx II) TimeLine’s popular se-
ries of external transport synchronizers. 
Normally, one Lynx-series module is 
needed for each master and each slave. 
PostConform, however, can directly con-
trol any machine that’s connected to a sin-
gle Lynx module.

Machine Control With a DAW such as a Pro 
Tools system, machine control is the ability 
to control an external transport, typically a 
VTR or ATR. Implicit in machine control is 
full transport synchronization, where the 
DAW (as master) can control all functions 
of an external slave. Basic machine control 
requires that the master machine simply 
put out a standardized command set, such 
as Sony 9-pin. More elaborate machine 
control usually requires the master ma-
chine to be programmed with individual 
transport protocol and ballistics—that is, 
what commands may be required to yield 
specific responses (such as going into fast-
forward, or play), and how quickly the 
transports wind, brake, sync up, and so 
forth. Alternately, machine control re-

quires a third-party device between the 
master and the slaves, such as Videomedia 
V-LAN device or TimeLine Lynx II

Master (Master Tape/Reel) A videotape or 
film reel that is assembled from edited 
source material. 

Master (Master Transport/Deck) The 
“lead” machine or DAW in a synchronized 
machine arrangement. Slaves follow mas-
ters. There can only be only master at any 
given time. 

Mode (EDL Mode) An EDL’s mode refers to 
how an EDL’s events are ordered. The most 
common modes are “A,” “B,” and “C.”

MTC MIDI Time Code. An industry stan-
dard for transmitting the MIDI equivalent 
of SMPTE time code between devices. 
While not the same as SMPTE time code 
(it’s a digital, rather than analog signal, for 
one), a SMPTE-to-MTC converter can be 
used to bridge the gap. MTC can follow all 
the frame-per-second rates of SMPTE time 
code.

Negative Cut List A printed list that a film 
editor uses to (literally) cut film from 
source reels onto a master reel. 

Nonlinear Digital Video Editing System A 
video equivalent of a DAW. Most such sys-
tems are Mac- or PC-based, and record 
compressed digital video information to 
hard disks or optical disks, for completely 
random-access editing of both visuals and 
audio information. Final sessions are usu-
ally transferred to video, or, if the system is 
used offline, an EDL can be passed on 
floppy disk from the digital video editing 
system to an online video editing system. 
(For film production, these systems can 
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also be used to create the negative cut list.) 
PostConform can be used to import CMX-
compatible EDLs from these systems. 

Non-Drop-Frame Time code in which frames 
haven’t been “dropped.” The standard for-
mat outside of color video production or 
post production is typically 30 FPS non-
drop. 

Offline Editing In video editing, this is an 
editing process that typically uses dubbed 
worktapes to create a mocked-up master 
tape. EDLs from an offline editing system 
are usually transferred by floppy disk to an 
online system, to create a final master tape. 
An offline editing system saves wear-and-
tear on original source material, and is of-
ten equipped with less expensive gear than 
an online editing system.

Online Editing In video editing, this process 
typically uses original source tapes to as-
semble final master tapes, ready for broad-
cast, duplication, or other distribution. On-
line systems often operate using EDLs 
created with an offline system.

Offset A programmable differential in time 
between two audio or video devices. A nec-
essary feature for any machine control or 
synchronization.

Pre-Roll Used with machine control or syn-
chronization. Pre-roll allows the user to 
program a period of time that precedes a 
desired “sync time.” Serves two purposes. 
One is to allow a slower-locking machine 
(like an old ATR)—or a slow-responding 
synchronizer—to get up to speed before 
sync needs to be established. (I.e.: if a trans-
port requires 10 seconds just to get up to 
operating speed, then 10 seconds of pre-
roll will cause both master and slave to lo-

cate to a point 10 seconds before the actual 
desired location point.) The other purpose 
is in ADR or music production applica-
tions, where the talent may need some lis-
tening time to anticipate a punch-in or 
overdub. 

Post-Roll The “back-end” version of pre-
roll. Used to program the amount of time 
that passes after a desired “exit” time. A 10-
second post-roll programmed on top of 20-
second loop would functionally deliver a 
30-second long loop; that is, the slave 
would continue to play for a period of 10 
seconds after the end of the specified time 
period. 

QuickTime Apple’s system extension for 
control of time-based events, such as digi-
tized video “movies” and digitized sound. 
Pro Tools can import QuickTime movies, 
which can be used for frame-accurate sync 
when spotting audio.

Record In and Record Out  In video post 
production, these indicate where a given 
video or audio event should begin and end 
on the master tape. With PostConform, 
these are the time code addresses, as usu-
ally indicated on an EDL, to which auto-
loaded source material is autoconformed. 

Reel A term from the film world. Literally it 
refers to a reel of film; film editors usually 
work with one 10-minute reel at a time. 
Some audio post-production engineers di-
vide their audio session into 10-minute 
“reels” of audio, even if the audio stays en-
tirely on disk.

Rippling The process by which an edit 
change causes all elements to shift back-
ward or forward in time by “x” amount. 
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50
RT-11 An older EDL floppy disk format. 
Utilities, such as ALBA Editorial’s EDL Pro, 
can convert RT-11 format disks to DOS or 
Mac format. 

Slave The machines that “follow” the mas-
ter in a synchronized machine arrange-
ment. There can be multiple slaves—typi-
cally between one and five slaves—during 
the average video post-production session. 
Using its machine control capabilities. 

SMPTE/EBU Time Code The standard time 
code of Society of Motion Picture and Tele-
vision Engineers/European Broadcasters’ 
Union. Divides time into hours:min-
utes:seconds:frame:subframes. Typical 
frame-per-second rates include 24 (film), 
25 (PAL video), 29.97 (NTSC color video), 
and 30 (NTSC Black and White video). 
29.97 fps and 30 fps formats can be in 
drop-frame or non-drop-frame formats.

Sony 9-Pin (P-2) An industry standard for 
basic machine control of Sony-style video 
and audio transports. Refers to the D-B9 9-
pin physical external control connector 
found on Sony BVU and virtually all other 
video tape recorders.

Source Deck/Machine/Transport An ATR, 
VTR, or DAW from which source material 
is played back. Using its machine control 
capabilities, PostConform can autoload 
source audio from a source deck.

Source In and Source Out In video post pro-
duction, these indicate where a given video 
or audio event is located on its respective 
source tape. With PostConform, source 
tapes are shuttled to the source in time. 
Then, the source deck is put into play, Post-
Conform is put into record, and the source 
material is autoloaded to the hard disk. 

Once the source tape comes to the event’s 
source out time, the deck is stopped, and 
PostConform drops out of record mode. 

Source Tape/Reel/Material The video, film, 
or audio reels or tapes—or even disks or CD 
sample libraries—in which original video 
or audio material is located. With PostCon-
form, these are the source(s) for audio 
events that get autoloaded during the auto-
assembly process. 

Synchronization The process of having two 
or more audio, video, or other devices run 
together at exactly the same speed (usually 
during playback, though sync during 
record, fast-wind, and “crawls” is possible). 
Requires the use of an external or plug-in 
transport synchronizer, which can com-
pare the relative SMPTE/MIDI time code 
positions of two or more devices, and can 
compensate for any variances on the part 
of the slaves to help align the master and 
its slave(s). Aside from an outboard box or 
plug-in card, synchronization can be ob-
tained via built-in machine control (found 
in some DAWs), or via a software-only so-
lution, such as MIDI Time Code, say, be-
tween a DAW and an external sequencer, 
drum machine, etc. 

Take In film and video production, a take is 
a scene or portion of a scene filmed or re-
corded in one pass. In post production, an 
EDL consists of desired takes, or portions of 
desired takes, the sum of which will be used 
to make the master reel or tape. Once a take 
is part of an EDL, it is synonymous with an 
event or an edit.

Time Code See SMPTE/EBU Time Code.
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Time Code DAT A means of recording and 
playing back SMPTE/EBU time code infor-
mation on a DAT machine, while leaving 
its two audio tracks free for audio. Time 
code DAT decks are also able to be synchro-
nized, using a transport synchronizer, a V-
LAN system, or in some cases, Sony 9-Pin 
format. Many also have built-in chase syn-
chronizers.

Time Compression/Expansion The process 
of lengthening or shortening a specific re-
gion of audio or video, typically while 
maintaining the original audio pitch or ap-
parent video speed.

Transport Synchronizer Usually a stand-
alone or plug-in device, capable of “lock-
ing” two or more transports together. At 
the very least, a synchronizer must be able 
to read and compare time code from a mas-
ter and slave, and control the slave’s trans-
port to follow the master when the master 
is in play. More advanced synchronizers, 
such as TimeLine’s MicroLynx, are able to 
control the master device, and to have the 
slaves “chase lock” to the master whenever 
it leaves play and goes into a fast-wind 
mode. 

Universal Slave Driver (USD) Digidesign's 
flagship synchronization peripheral. Locks 
to all major industry standard clock for-
mats and positional reference types. Sup-
ported by PostConform for near-sample-ac-
curate lock to external decks.

Video Editor/Video Editing System A system 
that typically controls at least three video 
transports (two source slaves and one mas-
ter), to compile and edit a finished master 
tape. The most common systems are made 
by CMX, Sony, Ampex, Grass Valley, Abe-
kas, and others. 

VITC Vertical Interval Time Code. Unlike 
LTC, which is analogous to an audio signal, 
VITC is stored within the “vertical blank-
ing interval” of the video tape, embedded 
as part of the video signal. Provides true 
frame-accurate time code relative to the 
video. Can also be read while a video tape is 
paused or stopped, because the video heads 
continue to spin relative to the tape. Re-
quires a more specialized form of time code 
reader than LTC. Pronounced vit-see. 

V-LAN Videomedia’s machine control stan-
dard. V-LAN is a network of programmable 
transmitters and receivers that allows con-
trol/connection with a simple BNC con-
nector. Stands for Videomedia Local Area 
Network. Via a V-LAN transmitter, both 
PostConform and PostView offer direct 
control of any ATR or VTR connected to a 
V-LAN receiver. 

VPR-3 A machine control standard, devel-
oped by Ampex. An alternative standard to 
Sony 9-Pin; this is the protocol by which a 
Lynx I or Lynx II is controlled by 
PostConform.

VTR Video Tape Recorder. Refers to both 
open reel and cassette decks.

Worktape A video tape, usually 3/4" or 1/2", 
made from a rough-cut or final-cut of a film 
or video. Audio post engineers typically as-
semble their audio elements while using a 
worktape. This prevents wear and tear on 
the original film or video, and it also allows 
the post-production house to use video in-
stead of film as the visual reference (handy 
since synchronizing film projectors can be 
expensive, slow, inconvenient, and diffi-
cult).
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